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1. Introduction 

ConcreteWorks is designed to be a user-friendly concrete mixture proportioning, thermal 

analysis, and chloride diffusion service life software package.  The software package 

contains design modules for several mass concrete shapes, bridge decks types, precast 

concrete beams, and concrete pavements.  Table 1 shows the software analysis modules 

available for each member type. 

Table 1 - Software features available for each concrete member type 

Member Type 

Initial 
Chloride 

Profile Input 
for Existing 
Structures 

Chloride 
Service 

Life 

Thermal 
Cracking 

Risk 
Temperature 
Prediction 

Rectangular Column  X X X 
Rectangular Footing  X X X 
Partially Submerged 
Rectangular Footing  X X X 
Rectangular Bent 
Cap  X X X 
T-Shaped Bent Cap  X  X 
Circular Column  X  X Mass 

Concrete Drilled Shaft  X  X 
Box Beam (Type 
5B40)    X 
Type IV I-Beam    X 
U40 Beam    X 

Precast 
Concrete 
Members U54 Beam    X 

Pre-cast 1/2 Depth 
Panels X X  X 
Permanent Metal 
Decking X X  X 
Removable Forms X X  X Bridge Deck 

Types User-Defined X X  X 
Pavements User-Selected Layers    X 

 



In order to obtain accurate temperature, thermal stress, and corrosion risk calculations, 

the user should have a good understanding of the fundamental principles and mechanics 

employed in the software inputs and calculations.   It is assumed that users will have a 

good knowledge of fundamental concrete materials principles and practices. The purpose 

of this manual is not to give an exhaustive compilation on all concrete thermal, durability 

and corrosion research in the literature.  Instead, this manual is designed to give the user a 

working knowledge of concrete behavior needed to successfully use ConcreteWorks, 

built upon an already existing knowledge of fundamental concrete behavior.  It is 

recommended that users carefully read this user manual before using the software, as well 

as cited references when necessary.   

This manual is divided in several sections.  The first section is the information on the 

ConcreteWorks mixture proportioning guide.  The second section is on how the heat 

transfer calculations are performed.  The third section is on how the thermal stress 

analysis and consequent cracking risk assessment is done.  The fourth section is on the 

chloride service life model built into ConcreteWorks.  Finally, a ConcreteWorks 

operator’s manual is provided. 

2. Concrete Mixture Proportioning Guide 

2.1. Basic Mixture Proportioning 

The backbone for the mixture proportioning guide found in ConcreteWorks is the 

procedure outlined in the ACI 211 document “Standard Practice for Selecting Proportions 

for Normal, Heavyweight, and Mass Concrete” (ACI 211, 1991).  For a detailed 



explanation of this mixture proportioning method, users are encouraged to read the ACI 

211.1-91 document.   

The basic steps of the concrete mixture proportioning procedure can be summarized 

as the following:  

1. Determine the amount of water needed to achieve a given slump for the selected 

maximum aggregate size.  Make adjustments to the required water amount based on 

material conditions, chemical admixtures, air entrainment, etc. (covered in section 2.2 

of this manual) 

2. Determine the water to cementitious materials ratio (w/cm) needed for a given air 

content to achieve selected target strength.  The use of supplementary materials is 

assumed to not affect the w/cm needed to achieve the target strength (which may or 

may not be true depending on the reactivity of the material and the replacement rate).  

Supplementary cementing materials replacement percentages are only used in 

calculating the volume of cementitious materials.   

3. Make adjustments to the w/cm to account for maximum w/cm for given exposure 

conditions (chloride and sulfate exposure levels). 

4. Calculate the coarse aggregate fraction based on the maximum size aggregate, the 

sand fineness modulus, and the coarse aggregate dry-rodded unit weight. 

5. Calculate the amount of sand needed to fill the remaining concrete volume (that 

volume not already accounted for by the cementitious materials, water, coarse 

aggregate, or air).  The sand weight is then calculated for this volume using the sand 

specific gravity. 



The required water amount is calculated using Equation 1 and the coefficients found 

in Table 1 based on the ACI 211.1-91 Table 6.3.3.  The required water amount is then 

reduced by the percentages specified using the water adjustment factors discussed in 

section 2.2 and calculated using Equation 1: 

)1())ln(( WAbslaW ww  Equation 1 

where W is the required water (lb/yd³), aw and bw are constants determined from Table 2 

(lb/yd³), sl is the desired concrete slump (in), and WA is the water reduction factor.  The 

amount of water needed to obtain the required slump increases as the maximum 

aggregate size decreases and consequently the total aggregate surface area increases.   

Table 2 – Concrete water requirement and coarse aggregate volume fit parameters based on the
maximum size aggregate

Maximum Aggregate Size (in) 
aw 

(lb/yd³) 
bw 

((lb/yd³) 
aca

2 27.411 249.41 0.78 
1.5 27.411 264.41 0.75 
1 27.411 289.41 0.71 

0.75 30.618 302.31 0.66 
0.5 34.176 321.45 0.59 

0.375 40.941 333.49 0.5 
 

The connection between compressive strength and w/cm was first published in 

1918 by Duff Abrams.  W/cm is one of the major factors in determining the concrete 

porosity and consequently compressive strength (Mindess, Young, and Darwin, 2003).  

Air entrainment will increase the amount of voids in concrete, and consequently reduce 

the strength.  The required w/cm ratio is calculated using Equation 2-4: 

))ln((/ '

acta bfacmw  Equation 2 

3762.0*00065.0 airaa  Equation 3 

7275.3*0263.0 airba  Equation 4 



where air is the percent air in the concrete, and fct’ is the concrete target strength.  

Equations 3 and 4 were calculated using a regression analysis from the data found in ACI 

211.1-91 table 6.3.4 assuming the quoted values of 2% entrapped air for the non-air 

entrained concrete and 6% for the air entrained concrete.   

The coarse aggregate weight is calculated using Equation 5: 

DRUWFMaCAW ca )
10

)4.2((  Equation 5 

where CAW is the coarse aggregate weight (lb/yd3), aca is a fit parameter found in Table 

2,  FM is the fineness modulus, and DRUW is the coarse aggregate dry rodded unit 

weight (lb/yd3).  The coefficient aca was found by fitting the data found in ACI 211.1-91 

Table 6.3.6. 

2.2. Water Adjustments

The required water adjustments procedures and magnitudes are based on the NHI Course 

15123 Participant Workbook (Hover, 2003).  The amount of water adjustment needed for 

each material used is highly material dependent.  A good amount of knowledge and 

experience with the local materials used is critical to accurately estimate the influence of 

the material on the concrete mixture.  A trial batch is needed to confirm the validity of the 

concrete mixture designed, and to make any necessary adjustments to the concrete 

workability.   

The range of water adjustment permitted for different materials in ConcreteWorks is 

that suggested by the NHI course 15123 Participant Workbook (2003) and shown in 

Table 3. Water reducing chemical admixtures will reduce the required water content in 

the concrete mixture by different amounts depending on the chemical admixture 



chemistry and dose used.  Values selected for water reducers should be based on 

experience or recommendations from the chemical admixture supplier.  Air entrainment 

will also increase the concrete workability by both chemical and physical means 

(Mindess, Darwin, and Young, 2003).  The effect of supplementary cementing materials 

will depend on the particle size and shape.  Silica fume will greatly increase the water 

demand and should not be used without a high range water reducer that will aid in the 

dispersion.  Fly ash can however increase the workability, although the amount is very 

material dependent.  Aggregates will also have a large effect on the concrete workability.  

Poorly shaped and graded aggregates will have a very high water demand.  Round, 

smooth and well-graded aggregates will however decrease the concrete water demand. 

Experience with the local aggregates used is especially necessary when gauging the 

amount of water adjustment needed in the mixture proportioning.   

Table 3 - Range of Water Adjustment Factors used in ConcreteWorks (Hover, 2003) 

Factor 

Water Adjustment Range 
(a negative value  is a 

water reduction) 
ASTM  Type A  Low 
Range Water Reducer 

0 -10 

Mid-Range Water 
Reducer 

-8 -15 

ASTM Type F High 
Range Water Reducer 

-12 -30 

Air Entrainment 0 -10 
Aggregate Shape & 
Texture 

5 -5 

Aggregate Gradation -10 10 
Supplementary 
Cementing Materials 

-10 15 

 



2.3. Aggregate Gradations

There are three commonly used simple methods of optimizing aggregate gradations to 

decrease the amount of water needed in the concrete.   Two of the methods, the 0.45 

power curve method and the percent retained method, are based on the combined 

aggregate gradation.  The third method, the Shilstone Coarseness Factor –Workability 

Factor method (Shilstone, 2002) uses an empirical relationship between the percent 

retained on the No. 8 sieve, the percent retained on the 3/8” sieve, and the cementitious 

content to determine if a mixture is acceptable.   

The 0.45 power curve method is commonly used in asphalt aggregate gradations.  

The aggregate percent passing is plotted versus the sieve size to the 0.45 power on a log 

scale. The aggregate maximum density line is plotted on the same graph; with the percent 

passing (PP) calculated using Equation 6: 

45.0

D
dPP  Equation 6 

Where d is the sieve size (in), and D is the maximum aggregate size (in).  

The Shilstone Coarseness Factor-Workability Factor method uses an empirically 

derived, graphical relationship between aggregate gradation and cementitious content to 

classify a mixture as acceptable or not.  The coarseness factor is plotted on the x axis 

while the workability factor is plotted on the y axis.  The coarseness factor is the 

cumulative percent retained on the 3/8” sieve divided by the cumulative percent retained 

on the No. 8 sieve times 100 (%).  The workability factor is the “percent of the combined 

aggregate that passes the No. 8 sieve (Shilstone, 2002).”  The workability factor is then 

adjusted for the cementitious content by Equation 7: 



5.2*
94

5648 cmCAWF  Equation 7 

Where WF is the workability factor, CA8 is the combined aggregate that passes the No. 8 

sieve (%), and cm is the concrete cementitious material content (lb/yd3).  If the 

coarseness factor and workability factor for the mixture plots inside of an empirically 

derived box, defined below, then the mixture is deemed acceptable (Shilstone, 2002).  

The concrete mixture proportions acceptability box whose corners are shown in Table 4: 

Table 4 - Corners of box of acceptable mixtures for Shilstone Coarseness Factor-Workability Factor 
aggregate gradation method (TxDOT Special Provision 421)

Corner 
# 

Coarseness 
Factor 

Workability 
Factor 

1 68 36
2 68 32
3 52 38
4 52 34

 
The percent retained method involves plotting the percent retained on each sieve, and 

eliminating large valleys and peaks in the gradation.  This method is very subjective, but 

may help avoid having a very gap-graded mixture. 

3. Temperature Prediction

3.1. Heat Transfer Modeling

3.1.1. Fundamentals and Numerical Scheme

Heat transfer is governed by the second order differential equation known as the 

heat diffusion equation, as shown in Equation 8: 

t
Tcq

z
Tk

zy
Tk

yx
Tk

x p'  Equation 8 

 



where k is the material thermal conductivity (W/m/K), T(x,y,z)  (°C) is the scalar 

temperature field, q’ (W) is the heat generation term,  (kg/m3) is the material density, cp 

(kJ/kg/°K) is the material specific heat, and t (s) is the time (Incropera and Dewitt, 2002).     

Closed form solutions for the heat diffusion equation are only available for very 

simple geometries and conditions.  The heat transfer in real concrete members is much 

too complex for direct solutions.  Numerical approximations can however be used to 

estimate the concrete temperature development.  One such method is the finite difference 

method.  An energy balance on an assumed differential control volume can be used to 

account for all thermal energy changes inside the control volume, as shown in Equation 

9: 

stgenoutin EEEE  Equation 9 

where Ein (W) is the thermal energy entering the control volume, Eout (W)  is the thermal 

energy leaving the control volume, Egen (W) is the thermal energy being generated in the 

control volume (in the case of concrete, the heat generated by hydration), and Est (W) is 

the change in thermal energy stored in the control volume.  The energy entering and 

leaving the control volume by conduction is equivalent to the first three terms in the heat 

diffusion equation.  The heat generation term is the chemical energy being released in the 

control volume.  The change in heat energy being stored in the control volume is equal to 

the change in temperature in the control volume times the specific heat and density.  The 

temperature and material properties are assumed to be constant for each control volume.  

Sufficiently small control volumes must then be used to adequately approximate the heat 

transfer for each volume. 



Figure 1 shows three neighboring control volumes with insulated sides.   An 

explicit time discretization has been used in formulating these equations which is 

explained in the section 3.1.2. The change in energy entering and leaving the control 

volume 2 can be calculated using Equation 10 and Equation 11. 

 

Figure 1 - Control volume example - three neighboring nodes 

 

323211 aTaTEin  Equation 10 

322212 aTaTEout  Equation 11 

where T1, T2, and T3 are the temperatures at the respective nodes shown in Figure 1 for 

the current time step (°C), a1-2 and a2-3 are defined by Equation 12 and Equation 13 

(Patankar, 1980).   



y
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dx

k
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1

2

2

1

1
21  Equation 12 

y
k
dx

k
dxa

1

3

2

2
32 3

 Equation 13 

where dx1, dx2, dx3, and y are as shown in Figure 1 (m); k1, k2, and k3 are the thermal 

conductivity for the material in the respective control volume (W/m/K).  The energy 

generated in control volume 2 is equal to the heat generated by hydration per unit mass of 

cementitious materials times the mass of cementitious materials in the control volume as 

shown in Equation 14.  

yxQEgen 2  Equation 14 

where Q is the heat generated per unit mass of cementitious materials (W); x2 and y 

are as shown in Figure 1 (m).  For control volume 2, Q may be calculated based on the 

Arrhenius equation as shown in Equation 15 (Schindler, 2004): 

3600
1

273
1

273
1expexp*)(

2TTR
E

ttt
CHtQ

r

a

e

u

ee

cue

 

Equation 15 

where te is the concrete equivalent age at the reference temperature as shown in Equation 

16 (hrs), Hu is the total amount of heat generated at 100% hydration (J/kg), Cc is the total 

amount of cementitious materials (kg/m3),  is the hydration time parameter (hrs),  is the 

hydration slope parameter, u is the ultimate degree of hydration, Ea is the activation 

energy (J/mol), R is the universal gas constant (J/mol/K), and Tr is the reference 

temperature (°C).  The degree of hydration is calculated as shown in Equation 17. 

dt
TTR

AETt
t

r

e
0

2

2 273
1

273
1exp)(  Equation 16 



e
ue t

t exp)(  Equation 17 

The change in energy stored in the control volume is shown in Equation 18. 

t
TTyxc

E p
st

)( 2
1

2222  Equation 18 

cific 

heat in control volume 2 (J/kg/K), T2 is the temperature at node 2 for th step 

(°C), T  is the temperature at node 2 for the current time step (°C), and t is the time step 

(seconds).   

Boundary conditions are easily handled using the energy balance approach.  A control 

volume with a side exposed to convection is shown in Figure 2.   

where 2 is the material density in control volume 2 (kg/m3), cp2 is the material spe

+1 e next time 

2

   
Figure 2 - Example of control volume with a convection boundary condition

A “half control volume” is used for control volumes located on an external boundary 

tankar, 1980). The conduction energy entering or leaving that side of the control (Pa



volume can be replaced with the convection energy entering or leaving the control 

volume, as shown in Equation 19 and Equation 20:  

yhTaTEin 211  Equation 19 

yhTaTEout 2212  Equation 20 

where h is the convection heat transfer coefficient (W/m2/K).  Radiation and irradiation 

terms may be similarly added to Ein and Eout.  Constant temperatures, suc und 

3.1.2. Time Discretization 

To calculate the temperature in a node, the temperature variation with time needs 

to be as s to assume that the integral with respect to time 

and tem

22

t + t is the end of the time 

step in question (s), f is a constant between 0 and 1, T2
 +1 is the temperature at node 2 at 

h as those fo

at the concrete exterior of a submerged concrete member may be enforced by setting the 

next time step for the control volume equal to the prescribed temperature.  

sumed.  A common assumption i

perature is a linear combination of the temperature at the beginning and end of 

the time step as shown in Equation 21 (Patankar, 1980). 

tTfTfdtT
tt 1 )1(  Equation 21 

where t is the beginning of the time step being evaluated (s), 

t p

the end of the time step (°C), and T2 is the temperature at node 2 at the beginning of the 

time step (°C).  When f is chosen to be 0, the time discretization is said to be fully 

explicit and the temperature during the time step is assumed to be equal to the beginning 

temperature during the time step.  If f is greater than 0, the method is called implicit.  If f 

is assumed to be 1, the method is called fully implicit.  The temperature during the time 

step is then assumed to be equal to the ending temperature during the time step.  Explicit 



methods allow for temperature calculations directly from previous time step 

temperatures.  Implicit methods however, are dependent on unknown temperatures.  A 

system of unknown temperatures must be solved for simultaneously (Patankar, 1980).  

When the explicit method is used, the temperature at a node for the next time step is 

completely dependent on the current time step.  This means that the unknown 

temperatures for the next time step do not have to be solved simultaneously. 

If care is not taken when fully explicit methods are used, unstable results may be 

calculated.  The stability criterion is shown in Equation 22:  

t
Tyxcp 2222Eout  

where Eout, 2, cp2, x2, y, T2, and t are as defined above.  Equation 9 means that the 

amount of energy leaving the control volume has to be less than the amount of the energy 

3.1.3. Symmetry

The use of symmetry can significantly decrease the amount of computations needed.  

At a lin rivative of the temperature profile is zero.  This implies that 

ther

Equation 22 

stored in the control volume to give physically possible results.  As seen in Equation 22, 

as the control volume decreases, the time step must also decrease.  As a result, explicit 

finite difference methods can be computationally expensive.   

e of symmetry, the de

e is no heat exchanged across the line of symmetry.  The energy leaving and entering 

the face of the control volume on the line of symmetry is set equal to zero.  The 

assumption of symmetry may lead to some inaccuracies when modeling boundary 

conditions, such as when one side of a concrete member is shaded and the other is not.  If 



symmetry where not assumed, longer run times would occur and more complex program 

inputs (including inputs that may not be available to the engineer) would be required.   

3.1.4. Concrete Thermal Properties 

Becaus ies of concrete, the concrete thermal e of the constantly changing early age propert

properties must be updated at every time step.  The thermal conductivity is known to be a 

function of “the moisture content, content and type of aggregate, porosity, density and 

temperature (Van Breugel, 1998).”  The concrete thermal conductivity increases with 

increasing moisture content.  There is conflict in the literature about the change in 

thermal conductivity with increasing hydration.  Some suggest that the thermal 

conductivity increases with the degree of hydration, while others report that it decreases 

up to 30% (Van Breugel, 1998; Schindler, 2002).  Based on the recommendation of 

Schindler (2002), ConcreteWorks assumes a linear decrease of the thermal conductivity 

with the degree of hydration from 1.33 times the ultimate thermal conductivity to the 

ultimate thermal conductivity as shown in Equation 23: 

)33.033.1()( ucc kk  Equation 23 

Where kc is the concrete thermal conductivity (W/m/K),  is the degree of hydration, and 

f concrete is also dependent on the mixture proportions, degree of 

hydration, temperature and moisture level (Van Breugel, 1998; Schindler, 2002).  A 

kuc is the ultimate hardened concrete thermal conductivity.  The thermal conductivity of 

the concrete is not adjusted for moisture content in ConcreteWorks because the moisture 

content in mass concrete does not change significantly during early ages.  The thermal 

conductivity is also not adjusted for temperature because of the differing responses of 

different aggregates.   

The specific heat o



model proposed by Van Breugel accounts for changes in the specific heat based on 

degree of hydration, mixture proportions, and temperature as shown in Equation 24: 

))1((1
wwaacccefc

conc

pconc Equation 24
cWcWcWcWc

 

where cpconc is the specific heat of the concrete (J/kg/K), conc is the concrete density 

kg/m3), Wc is the weight of cement (kg/m3), Wa is the weight of aggregate (kg/m3), Ww 

3.1.5. Concrete Heat of Hydration

The concrete heat of hydration parameters Hu, , , u, and Ea can be calculated based on 

the con t material properties.  The , , u 

(

is the weight of water (kg/m3), Cc is the cement specific heat (J/kg/K), Ca is the aggregate 

specific heat (J/kg/K), Cw is the water specific heat (J/kg/k), and Ccef is a fictitious 

specific heat of the hydrating cement as shown in Equation 25: 

3394.8 cref Tc  Equation 25 

where Tc is the concrete temperature (°C). 

crete mixture proportions and constituen

parameters are calculated from a statistical analysis developed based on over 300 semi-

adiabatic calorimetry tests performed according to recommendations from the RILEM 

technical committee 119 (1998) and validated by 18 tests conducted on concrete sampled 

from concrete construction sites and 44 tests conducted independently by Schindler and 

Folliard (2005) and Ge (2006).  The dataset used includes concrete containing various 

chemical admixtures, cement fineness and chemical composition, and supplementary 

cementing materials on the heat of hydration.  The apparent activation energy Ea can also 

be calculated based on the cementing material properties and the chemical admixtures 



used.  A statistical analysis of 117 apparent activation energies calculated from 

isothermal calorimetry was developed by Poole (2007).  The Hu parameter can also be 

calculated from the cement chemical composition using a model developed by Schindler 

and later altered to better characterize the influence of grade 120 ground granulated blast 

furnace slag by Poole (2007).  The cement composition can be defined in ConcreteWorks 

using either the Rietveld method (Rietveld, 1969) determined from quantitative x-ray 

diffraction or the Bogue method calculated according to ASTM C 150 (2005).  When the 

Rietveld method is used to determine the cement chemical composition, Equation 26-31 

are used in ConcreteWorks to calculate the concrete heat of hydration parameters: 
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where palite is the percent alite content in the Portland cement, pcem is the percent portland 

cement of total cementing materials, pNa2Oeq is the percent sodium equivalent alkalis in 

the portland cement, pNa2O is the percent Na2O in the Portland cement, pAluminate is the 

percent aluminate in the Portland cement, pBelite is the percent belite in the Portland 

cement, pFerrite is the percent ferrite in the Portland cement, psulfate is the percent total 

sulfate in the Portland cement, pLime is the percent Lime in Portland cement, pPericlase is the 

percent periclase in the Portland cement, pCaSO4*xH2O is the percent total Gypsum in the 

Portland cement, pFA is the percent fly ash of the total cementing materials, pFA-CaO is the 

percent CaO content of the portland cement, pGGBFS is the percent ground granulated blast 

furnace slag of the total cementing materials, pSF is the percent silica fume of the total 

cementing materials, WRRET is the ASTM Type B & D water reducer/ retarder dose, 

PCHRWR is an ASTM Type F polycarboxylate based high range water reducer dose, 

LRWR is the ASTM Type A water reducer dose, MRWR is the mid-range water reducer 

dose, NHRWR is the Type F naphthalene high range water reducer dose, and ACCL is 

the ASTM type C accelerator.  The chemical admixture dosages are in percent solids by 

weight of cementing materials.  

 When the Bogue method is used however, ConcreteWorks uses Equation 32-37 to 

calculate the concrete heat of hydration parameters:  
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where pC3S is the percent alite content in the Portland cement, pC3A is the percent 

aluminate in the Portland cement, pC2S is the percent belite in the Portland cement, pC4AF 

is the percent ferrite in the Portland cement, pSO3 is the percent total sulfate in the 

Portland cement, pMgO is the percent MgO in the Portland cement and pfreeCa is the percent 

CaO in the portland cement.  To simplify the inputs needed, ConcreteWorks uses average 

assumed chemical admixture dosages as shown in Table 5: 

Table 5 - Chemical Admixture Dosages Assumed in ConcreteWorks

Chemical 
Admixture 

Dose by Mass of 
Cementing 

Materials (%) 
LRWR 0.0029 



WRRET 0.0035 
MRWR 0.0032 
NHRWR 0.0078 
PCHRWR 0.0068 
ACCL 0.013   

3.1.6. Boundary Conditions 

In calculating the heat transfer of concrete members, the boundary conditions are usually 

the most difficult parameters to quantify.  ConcreteWorks makes numerous assumptions 

about the heat sources and sinks that are external to the concrete, depending on the 

member type chosen.  The heat sources and sinks modeled in ConcreteWorks may 

include: Irradiation from the member, radiation from the ground, radiation from the air, 

solar radiation, radiation from the formwork, convection to/from the member, 

evaporative cooling, conduction to the soil/subgrade, and exposure to water.  The amount 

of each heat source or sink that is included in ConcreteWorks depends on the member 

type, shading effects, and other user inputs.  More details on the assumptions made for 

each member type are discussed in section 3.2.   

There are numerous equations needed to model each type of heat source or sink in 

ConcreteWorks.  Details about many of the boundary conditions equations used in 

ConcreteWorks, especially for vertical members may be found in the paper “Temperature 

Boundary Condition Models for Concrete Bridge Members (Riding ET Al, 2007).”  The 

evaporative cooling model is from Schindler (2002).  It combines models from the 

ASHRAE handbook (1993) and Al-Fadhala and Hover (2001) to predict the evaporation 

and consequently the cooling rate for concrete surfaces.  The model is based on the work 

of Menzel that applied water evaporation rate equations developed by Koehler to 

concrete.  The evaporation rate follows Dalton’s law, which relates the water-vapor 



pressure of the air, at the water surface, and the wind speed (which helps speed up 

evaporation) to the evaporation rate (Hover, 2006).  Menzel’s equation is shown as 

Equation 38 (Al-Fadhala and Hover, 2001): 

)060.0253.0)((315.0 0 weRHeE aw  Equation 38 

where Ew is the water evaporation rate (kg/m2/hr), e0 is the water surface saturated water 

vapor pressure (mmHg), ea is the air water vapor pressure (mmHg), RH is the relative 

humidity (as a decimal), and w is the wind speed (m/s).  The terms e0 and ea are 

dependent on the water surface and air temperatures.  Concrete follows Dalton’s law 

pretty well when bleed water is on the surface, and decreases rapidly during setting.  The 

amount of evaporation from concrete may be related to the amount of evaporation from a 

water surface by Equation 39 (Al-Fadhala and Hover, 2001): 
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 Equation 39 

Where Ec is the evaporation rate from concrete (kg/m2/hr), t is the time from mixing 

(hrs), and aevap is mixture dependent time constant (hrs).  ConcreteWorks assumes that 

aevap is equal to 3.75 hrs.  The evaporative cooling model is applied until either a cure 

method is applied or 24 hours after placing.   

3.2. Concrete Member Models

Each type of concrete member modeled in ConcreteWorks has different formwork, 

boundary conditions, geometry, and opportunities to use symmetry.  Different nodal 

arrangements are also required to keep nodes in a regular pattern and in line.   



3.2.1. Rectangular Column

ConcreteWorks models a 2D horizontal cross section for rectangular columns, as shown 

in Figure 3.  The column heat transfer in the vertical direction is assumed to be zero, 

which is a reasonable assumption except near the top and bottom ends of the column. 

Rectangular columns are modeled using symmetry in both directions as shown in Figure 

4.  The formwork is handled by using half control volumes around the concrete, as shown 

in Figure 5.  ConcreteWorks allows the user to select up to three construction stages to 

model for rectangular columns by selecting different formwork removal times and curing 

techniques.   

Horizontal Cross 
Section Assumed for 
Rectangular Column 

 
 

Figure 3 – Horizontal cross section of rectangular column assumed in ConcreteWorks

 



 

Figure 4 - Simplified rectangular column model used in ConcreteWorks

 

Figure 5 - Example rectangular column node and control volumes 



The first construction stage is during concrete placement and curing before form removal.  

When steel formwork is selected and form-liners are not selected, ConcreteWorks 

assumes that the steel provides no insulation because of the “little resistance to heat 

dissipation from the concrete (ACI 207.2, 1995).”  The steel emissivity, absorptivity, and 

shading values are then assigned to the concrete surface node, so that the surface of the 

column will still see the same heating from the environment.  Eliminating the form 

control volumes for steel formwork greatly increases the runtime because of the small 

time step needed to maintain stability with such a thin control volume needed to model a 

steel form.  When form-liners are used, ConcreteWorks calculates an equivalent form 

thermal conductivity, density and specific heat for the selected combination of form and 

form-liner.  The thermal conductivity, density, and specific heat of the equivalent form 

are calculated using Equation 40-42: 
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Where kef is the effective form thermal conductivity (W/m/K), wf is the width of the form 

(m), wfl is the width of the form-liner (m), kf is the form thermal conductivity (W/m/K), 

kfl is the form-liner thermal conductivity (W/m/K), ef is the effective form density 

(kg/m3), f is the form density (kg/m3), fl is the form-liner density (kg/m3), cpef is the 

effective form specific heat (J/kg/K), cpf is the form specific heat (J/kg/K), and cpef is the  

form-liner specific heat (J/kg/K).  In ConcreteWorks, formliners are assumed to have a 



thickness of 0.036 m (1.4 in), a thermal conductivity of 0.7437 W/m/°C, a specific heat 

of 1549.1 J/kg/K, and a density of 1121 kg/m3. 

The second construction stage modeled is after form-removal and before curing 

techniques such as plastic, cure blankets, or cure compounds are applied.  An example of 

a structure during the beginning of the second construction stage is shown in Figure 6.  

The formwork is virtually removed in ConcreteWorks by eliminating the formwork 

control volume, and applying boundary conditions such as convection and radiation 

directly to the surface concrete control volumes.  Concrete emissivity, absorptivity and 

surface roughness values are assigned at this point to the surface concrete control 

volumes.   

 
Figure 6 - Rectangular column during form removal and the beginning of construction stage two
 



Construction stage three is during the time period of concrete curing using blankets, 

curing compounds or plastic.  When only curing compounds or only plastic are used, 

ConcreteWorks assigns the curing compound or plastic emissivity, absorptivity and 

roughness values to the concrete surface control volumes.  When curing compounds are 

used in conjunction with plastic or blankets, the effect of curing compounds is assumed 

to be negligible.  When blankets are used but no plastic is used for curing, half control 

volumes (similar to those used for modeling the formwork) are applied to the exterior of 

the concrete control volumes.  Blanket thermal and roughness properties are assigned to 

the exterior half control volumes.  When plastic and blankets are used to cure the 

concrete, blanket insulation properties (thermal conductivity, specific heat, density, and 

thickness) are assigned to the exterior half control volumes while the plastic emissivity, 

absorptivity and roughness values are used.   

Blanket insulation properties are calculated from the blanket R-value entered by the 

user.  The R-value is equivalent to the thickness divided by the thermal conductivity.  

ConcreteWorks assumes a blanket thickness of 0.02 m and then solves for the blanket 

thermal conductivity kbl (W/m/K) as shown in Equation 43: 

bl
bl R

k 02.0
 Equation 43 

where Rbl is the blanket R-value (m2K/W).  The specific heat of the wet blanket is 

assumed to be 320 kg/m3 while the specific heat is assumed to be 2000 J/kg/K.   

3.2.2. Rectangular Footing

Footings have some unique features that require special cases for modeling.  When 

footings are modeled in 2-D, ConcreteWorks assumes a vertical cross-section of the 



footing as shown in Figure 7 with no heat transfer perpendicular to the cross-section. The 

heat exchange between the footing and the environment is dependent on: the formwork, 

cure blankets and plastic used, soil conditions, weather, orientation of the footing, 

shading from scaffolding and embankments, and heat conduction from the concrete 

interior.  Figure 8 summarizes the footing surface boundary conditions.  

 

Vertical 
cross 
section 
modeled in 
2-d footing 

Figure 7 – Diagram of the vertical cross section assumed in modeling a 2D footing



 

Figure 8 - Summary of Rectangular Footing Boundary Conditions

Radiation

Solar Radiation, atmospheric radiation, irradiation from the footing, and the radiation 

exchange between the vertical surface and form horizontal cross bracing models are used 

in the side and top boundary condition calculations.  Radiation emitted by the ground 

surface is assumed to be incident on the side surface only.  If the user chooses to shade 

the sides of the footing because of scaffolding or the embankment, then the solar 

radiation is set to zero. 

Conduction to/from Soil 

Conduction to / from the soil underneath the footing is modeled by assuming a constant 

depth of soil.  The initial temperature of the soil is set to the user defined average soil 

temperature.  The temperature at the bottom of the modeled soil is set also set to the user 



defined average soil temperature.  Table 6 shows the thermal properties of the different 

soil and rock types modeled by ConcreteWorks.  Figure 9 shows how the rectangular 

footing is modeled, and Figure 10 shows the node and control volume boundaries 

assumed.  Symmetry is assumed in the model in the width and length (when calculated in 

three dimensions) direction as shown in the figure.   

Table 6 - Footing Subbase Material Thermal Properties 

Subbase 
Material 

Density 
(kg/m3) 

Thermal 
Conductivity 
(W/m/K) 

Specific 
Heat 
(J/kg/K) Reference 

Clay 1460 1.3 880 
Granite 2630 2.79 775 
Limestone 2320 2.15 810 
Marble 2680 2.8 830 
Quartzite 2640 5.38 1105 
Sandstone 2150 2.9 745 
Sand 1515 0.27 800 
Top Soil 2050 0.52 1840 

Incropera and 
Dewitt, 2002 

Concrete - - -  
*Concrete is assumed to have the dame thermal properties of the concrete used on the 
footing, with a degree of hydration equal to 0.6.  This option is only available with 
rectangular footings without soil on the sides. 
 
 



 
 

 
Figure 9 - Rectangular footing model

 
Figure 10 - Node layout for rectangular footing



Construction Stages 

Rectangular footings can modeled with up to 4 potential construction stages.  The first 

stage is before the blanket is before any cure method is applied to the top surface.  The 

second stage is when the cure method is applied to the top surface.  ConcreteWorks 

assumes that a cure blanket is placed on the top surface when the cure method is applied.  

Any other cure methods such as plastic will also be placed and will affect the absorptivity 

and emissivity of the top cure surface.  The third stage is after form and cure method 

removal.  The fourth construction stage for the time period when a cure method of the top 

and sides I used after the forms and initial top surface curing methods are removed.  If a 

cure blanket is selected for this stage, it is applied uniformly over the top and side 

surfaces. 

3.2.3. Rectangular Footing with Soil on the Sides  

ConcreteWorks contains an option for soil to be used as the formwork, as shown in 

Figure 11.  Symmetry is assumed in the middle of the member as shown.  Conduction to / 

from the soil on the sides is treated in a similar manner to the soil underneath the footing.  

A constant thickness of soil is modeled on the sides of the footing.  The average soil 

temperature is enforced on the sides at the edge of the soil, as shown in Figure 12.  The 

node and control volume layout for the rectangular footing with soil on the sides is shown 

in Figure 13. 

 



 
Figure 11 – Summary of Rectangular Footing with Soil on the Sides

 
Figure 12 – Rectangular Footing with Soil on Sides Model



 
Figure 13 - Node and control volume layout for rectangular footing with soil on the sides

Construction Stages 

Rectangular footings surrounded by soil can contain up to two construction stages.  The 

first is before any cure methods are placed on the top surface.  The second is after cure 

methods are placed on the top surface.  It is assumed that a cure blanket is used in 

addition to any other cure methods applied. 

3.2.4. Bent Caps

The heat transfer at the exterior of the bent caps is handled using many of the same 

equations as that of the other concrete members.  There are a few types of bent caps, each 

with unique boundary conditions.  Symmetry is assumed in all bent cap members.   

Rectangular Bent Cap 

Figure 14 shows the vertical cross section assumed in the 2-dimensional heat transfer 

analysis performed for rectangular bent caps.  Figure 15 summarizes how ConcreteWorks 



models radiation for a rectangular bent cap.  Solar radiation is assumed to be incident on 

the top and side surfaces only.  Radiation from the ground surface is assumed to be 

incident on the bottom and side surfaces only.  Radiation from the atmosphere is assumed 

to be incident on all surfaces of the rectangular bent cap.  ConcreteWorks assumes that 

the rectangular bent cap emits radiation from all surfaces.  ConcreteWorks assumes that 

the wind creates convection on all of the rectangular bent cap surfaces, as shown in 

Figure 16.  ConcreteWorks allows the user to select different types of bottom and side 

formwork, as shown in Figure 17.  A summary of the node and control volume layout for 

rectangular bent caps is shown in Figure 18. 

  

Vertical cross 
section 
modeled in 2-d 
rectangular 
bent cap 

Figure 14 –Diagram of the vertical cross section modeled in a rectangular bent cap

 



 

Figure 15 -Rectangular Bent Cap Radiation Summary

 



 

Figure 16 -Rectangular Bent Cap Convection Summary



 

Figure 17 – Summary of Rectangular Bent Cap

 

Figure 18 - Node and control volume layout of rectangular bent cap 



Dolphin

ConcreteWorks allows the user to select pre-cast concrete as the bottom formwork 

material.  Pre-cast concrete is assumed to have the same material thermal properties as 

the concrete mixture used for the bent cap with a degree of hydration equal to 0.6.  When 

the user inputs that the bent cap is a dolphin, the temperature of the bottom of the bent 

cap is set equal to the average water temperature.  Figure 19 shows a summary of a 

dolphin with a pre-cast concrete bottom.   

 

Figure 19 - Summary of Dolphin with Pre-cast Concrete Bottom

3.2.5. T-Shaped Bent Cap 

The T-shaped bent cap modeled in ConcreteWorks assumes the same type of vertical 

cross section as the rectangular bent cap.  Figure 20 shows a summary of how 

ConcreteWorks models radiation boundary conditions in T-shaped bent caps.  Radiation 



from the ground surface is assumed to be incident on the cap bottom and sides.  Solar 

Radiation is assumed to be incident on all the top of the cap, the top of the corbel, and the 

sides.  Radiation from the atmosphere is assumed to be incident on all sides.  The cap is 

assumed to emit radiation from all surfaces.  ConcreteWorks assumes that the wind 

creates convection on all of the T-shaped bent cap surfaces, as shown in Figure 21.  

ConcreteWorks allows the user to select different types of bottom and side formwork, as 

shown in Figure 22.  The node and control volume layout for the T-shaped bent cap is 

shown in Figure 23. 

 

Figure 20 - Summary of Radiation Boundary Conditions for T-shaped Bent Caps 



 

Figure 21 - Summary of Convection Boundary Conditions on T-shaped Bent Cap

 

Figure 22 - Construction Summary form T-shaped Bent Cap



 

Figure 23 - Node and control volume layout for T-shaped bent caps

Construction Stages 

T-shaped bent caps use the same construction stages as rectangular bent caps.   

3.2.6. Circular Columns

ConcreteWorks models a horizontal cross section of the circular column, just like that of 

a rectangular column.  The boundary conditions for both rectangular and circular 

columns are handled in a similar manner.  Circular Columns are modeled in 

ConcreteWorks using the same radiation and convection boundary conditions as 

rectangular columns.  Figure 24 shows a summary of the construction model used for a 

circular column in ConcreteWorks.  Symmetry is assumed in the circumferential 

direction.   Figure 25 shows the node and control volume layout for a circular column.  

Figure 26 shows the boundary conditions modeled for circular columns.  ConcreteWorks 



applies convection on the outer surface of the model of the circular column.  Radiation 

from ground surfaces, atmospheric radiation, solar radiation, and irradiation are also 

modeled on the outer surface of the column. 

 

Figure 24 - Circular Column Model 

 

Figure 25 - Node and control volume layout for circular columns



 

Figure 26 - Circular Column Boundary Conditions

Construction Stages 

Circular columns use the same construction stages as rectangular columns.   

3.2.7. Bridge Decks

The fundamental heat transfer calculations performed for all four types of bridge decks 

modeled in ConcreteWorks are the same.  Figure 27 shows the basic layout of the bridge 

deck modeled.  In the case of a bridge deck with a precast panel, there is no bottom form 

modeled.  The precast panel thermal conductivity and specific heat properties are 

calculated using Equation 23 and Equation 24, with a degree of hydration equal to 0.6.  

The precast panel is assumed to generate no heat.  The bottom formwork is also not 

modeled when a galvanized panel is used.   The calculations are performed assuming 1-D 

heat transfer, and control volumes as shown in Figure 28.  The portion modeled is 



assumed to be open underneath the bottom form (i.e. not directly over a beam).  Figure 

29 shows the bridge deck temperature boundary conditions modeled in ConcreteWorks.   

 

Figure 27 - Bridge deck layout

 
Figure 28 - Bridge deck node and control volume layout



 
Figure 29 - Bridge deck temperature boundary conditions

Construction Stages 

Bridge decks have up to 4 possible construction stages.  The first is before the cure 

method is applied to the top surface.  A cure blanket is assumed to be used along with 

any additional methods selected by the user.  The second is after the cure blanket is 

placed on the top surface, but before form removal and cure method removal.  There are 

two possible final construction stages.  The first option for the third construction stage is 

for the formwork being on still, but with the cure method removed from the top surface.  

The first option for the fourth construction stage is for the form removed after the blanket 

is removed.  The second option for the third construction stage is for the formwork to be 

removed before the cure method is removed from top. The second option for the fourth 



construction stage is for the cure method to be removed after the bottom formwork is 

removed. 

3.2.8. Precast Rectangular and U-Shaped Beams 

Precast rectangular and U-shaped beams are handled in the same way in ConcreteWorks.  

Only the dimensions and number of nodes are changed, depending on which member is 

selected.  ConcreteWorks only models a vertical cross section of the solid beam end 

block, as shown in Figure 30.  Only the end block is modeled to greatly simplify the 

analysis, and to capture the maximum temperature in the beam, which occurs in the solid 

end region.  Figure 31 shows how the end region concrete, formwork and soil underneath 

is modeled in ConcreteWorks.  Figure 32 shows the node and control volume layout for 

the rectangular and U-shaped precast beams.   

 

Figure 30 - Modeled region of rectangular and U-shaped beams



 

Figure 31 - ConcreteWorks simplified model for rectangular and U-shaped beams

 

Figure 32 - Rectangular and U-shaped beam node and control volume layout



Boundary Conditions 

The rectangular and U-shaped beam model uses the same boundary conditions as the 

rectangular footing, except that a portion of the soil to the side of the beam is modeled.  

The soil surface to the side of the beam is modeled using irradiation, solar radiation, and 

convection. 

Construction Stages 

The rectangular and U-shaped beam model can have up to four construction stages.  The 

first is before the cure methods are applied.  The second is after the cure methods are 

applied.  It is assumed that a cure blanket is placed on top of the precast beam at this 

stage along with any other selected cure methods.  The third stage is for after the cure 

method and formwork is removed.  The fourth possible stage is for any further cure 

method application.   

 

3.2.9. Precast Type IV Beams 

The precast type IV beam model in ConcreteWorks models a vertical cross section 

through the middle of the beam.  The model assumptions are shown in Figure 33.  The 

type IV beam node and control volume boundaries assumed in the model are shown in 

Figure 34.   



 

Figure 33 - Precast type IV beam model assumed in ConcreteWorks

 

Figure 34 - Precast type IV beam node and control volume boundary layout



Boundary Conditions 

The precast type IV beam top and side boundary conditions include solar radiation, 

irradiation, radiation from the air, and convection.  In addition to conduction from the 

bottom of the member to the soil, convection is also allowed to occur because of a small 

gap of air that exists between the member bottom form and the ground underneath.  

Because the gap is not sealed, convection may occur resulting in cooling.   

Construction Stages 

The precast type IV beam utilizes the same construction stages as the rectangular precast 

beam.  

3.2.10. Pavements 

Pavements are modeled assuming 1 dimensional heat transfer in the vertical direction.  

Figure 35 shows the pavement layers modeled in ConcreteWorks.  The thermal 

conductivities, specific heat, and density values used for the pavement subgrade depends 

on the user inputs, according to Table 6.   



 

Figure 35 - Pavement layers modeled 

 

Figure 36 - Pavement node and control volume boundary layout



Boundary Conditions 

The top surface of the pavement is exposed to the same boundary conditions as the bridge 

deck top surface.  The pavement may be cured with a monomolecular compound, a single 

coat of curing compound, a double coat of curing compound, a clear or black plastic 

sheet, or a cure blanket.  If a monomolecular compound or a curing compound is used, 

then the user may enter the concrete color after the cure method application.  The cure 

method color will change the concrete surface emissivity and absorptivity.  Darker colors 

(like black and dark gray) have higher solar absorptivity and emissivity values than 

lighter colors (like white or light gray). 

The pavement layered system provides conduction to the supporting subbase layers and 

to the subgrade.  ConcreteWorks models 49.2 ft (15 meter) of subbase.  The temperature 

of the bottom of the subbase is modeled using the deep ground water temperature 

calculated using Equation 44 (Yoshitake, Nagai, Tanimoto, and Hamada 2002): 

7.383.0 aatgw TT  Equation 44 

Where Tgw is the deep ground water temperature (°C), and Taat is the average annual 

temperature (°C).  The average annual temperature in ConcreteWorks is calculated from 

the weather data entered for the city selected.  The soil about 0.6 m below the ground 

surface remains at a fairly constant temperature throughout the year ((Yoshitake, Nagai, 

Tanimoto, and Hamada 2002). 

The initial subbgrade and subbase temperature profile used in the analysis is then 

calculated using the Barber model. The Barber model can estimate the subbase and 

subgrade temperature profile based on the weather data selected in ConcreteWorks, as 

shown in Equation 45-51 (Barber 1957, Schindler 2002): 
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Equation 45 

L0.04985.0 AM TT         for T TA Equation 46 

L0.0498278.05.0 Am TT   for T<TA
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RV TT 5.0                                          for T<TA
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Where T(z) is the soil temperature (°C) at depth z (m), TM is the mean effective air 

temperature (°C) as calculated in Equation 46, TA is the mean air temperature (°C), L is 

the solar radiation (W/m2), TV is the maximum variation in temperature from the mean 

(°C) calculated using Equation 47, TR is the maximum daily temperature minus the 

minimum daily temperature (°C), H is calculated using Equation 48, w is the wind speed 

(m/s), k is the soil thermal conductivity (W/m2), C is the soil thermal diffusivity 

calculated using Equation 49 (m2/s), cp is the soil specific heat (J/kg/°C),  is the soil 

density (kg/m3), and t is the time from  the beginning of the temperature cycle (hours).  

The finite difference model excluding the concrete is then run from midnight of the 

placement date to the placement time to further improve the initial soil temperature 

profile.  The thermal conductivity, specific heat, density, solar absorptivity, and 

emissivity values assumed for different subbase materials is shown in Table 7: 



  
Table 7 - Pavement Subbase Material Properties 

Material 

Thermal 
Conductivity 
(W/m2) 

Specific 
Heat 
(J/kg/°C)

Density 
(kg/m3) 

Solar 
Absorptivity Emissivity 

Asphalt Concrete 1.38 1047 2302 0.93 0.93 
Cement Stabilized 
Base 0.985 985 2101 0.65 0.9 
Asphalt Stabilized 
Base 0.865 1025 2002 0.9 0.9 
Granular Base 1.59 1214 2066 0.8 0.9 
Existing Concrete 2.7 921 2403 0.55 0.92 

Construction Stages 

The pavement temperature analysis module contains 3 possible construction stages: 

before the cure method is applied, after the cure method is applied, and after the cure 

method is removed.  If a monomolecular compound or a curing compound is chosen, then 

it is assumed to stay on during the length of the analysis. 

4. Thermal Stress Analysis 

4.1. Overview 

Thermal stress modeling in concrete members is non-linear because of changing early 

age material properties (E modulus, strength, Poisson’s ratio, and Coefficient of Thermal 

Expansion), differential temperature development, and creep.   Figure 37 shows how the 

non-linear concrete property and restrained stress development is calculated in 

ConcreteWorks. 



 

Figure 37 - Flow chart describing the relationship between different parameters in thermal stress

modeling of concrete structures

 



In order to calculate the thermal stresses, the concrete member degree of hydration and 

temperature development must first be calculated as described in section 3.  Next, the 

degree of hydration and temperature development and is used to calculate the member 

mechanical properties the strains the concrete would undergo if there where restraint, 

including the elastic modulus development, Poisson’s ratio, the tensile strength 

development, the coefficient of thermal expansion, autogenous and drying shrinkage.    

Next, the concrete elastic stress must be calculated from the free shrinkage strains and 

mechanical properties by performing a structural analysis.  Stress relaxation may then be 

applied to the concrete elastic stress.  Finally, a failure criterion such as the stress to 

tensile strength ratio may be used to determine the cracking risk. 

4.2. Free Shrinkage and Mechanical Property 

Both the concrete the mechanical property development and the early-age free shrinkage 

strains are dependent on the concrete degree of hydration and temperature development.    

The mechanical property development is calculated using the equivalent age maturity 

(ASTM C 1074, 2004).  Several different equations have been developed to relate the 

maturity to strength development and are discussed in section 4.2.1. Section 4.2.2 

discusses the development of Poisson’s ratio. The free shrinkage strain is composed of 

the concrete thermal strains, the autogenous strains, the drying shrinkage strains, and the 

plastic shrinkage strains.   In mass concrete, the drying shrinkage may be assumed equal 

to zero for early-age analysis because of the small surface to volume ratio.  Free thermal 

deformation calculation methods are discussed in section 4.2.3 and autogenous shrinkage 

calculation methods are discussed in section 4.2.4. 



4.2.1. Concrete Maturity and Strength Development

The rate of cement hydration is dependent on the temperature and the time since mixing 

(Mindess, Young and Darwin, 2003).  Maturity is a method of comparing the cement 

hydration progress made at different temperature.  There are two maturity methods 

commonly used, both of which are described in ASTM C 1074 (2004).  They are the 

Nurse-Saul method and the Equivalent Age method.  The Nurse-Saul method concept 

was developed first in the 1950’s and uses a temperature-time factor to define maturity.  

The temperature-time factor may be defined as the integral of the temperature history and 

may be calculated using Equation 50 (ASTM C 1074, 2004): 

TTTtM a )()( 0  Equation 50 

where M(t) is the maturity (°C-hrs) at time t (hrs), Ta is the average temperature (°C) 

during time interval T (hrs), and T0 is the datum temperature (°C).  The equivalent age 

maturity is the age a concrete sample would have to be cured isothermally at some 

reference temperature Tr (°C) to have the same degree of reaction or properties as the 

sample cured at a different temperature.  The equivalent age maturity may be calculated 

using Equation 51 (ASTM C 1074, 2004): 
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where te is the equivalent age maturity (hrs), and Q is the activation energy divided by the 

gas constant (°K). ConcreteWorks uses the equivalent age maturity method because it 

does a better job of predicting the concrete strength development than the Nurse-Saul 

method (Emborg 1998a, Mindess, Young and Darwin 2003).  One of the problems with 

the maturity method is that curing at higher temperatures can result in lower long-term 



concrete strengths than concrete cured at lower temperatures, termed the cross-over effect 

(Emborg 1998a).  This effect does not usually occur until later ages, meaning that the 

maturity method may still be used at early-ages with little expected loss of accuracy.  For 

this reason, ConcreteWorks does not take the cross-over effect into account in calculating 

the strength from the maturity.  

Compressive Strength Development

A good model that describes the compressive strength development is essential in 

ConcreteWorks because it is used to calculate the elastic modulus development and the 

splitting tensile strength development.  The compressive strength is the most widely used 

strength quality control test.  Many engineers and contractors have already gained 

experience in developing compressive strength-maturity relationships, making it a much 

easier parameter for ConcreteWorks users to input than the modulus or splitting tensile 

strength to maturity relationship.   

Many equations of different forms have been developed to relate the compressive 

strength to the maturity development.  Two very common equations used are shown in 

Equation 52 and Equation 53 (Viviani, 2005): 
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Where fc is the compressive strength development (MPa), a is a fit parameter which is 

usually negative (MPa), b is a fit parameter (MPa/°C/hr), fcult is the ultimate compressive 

strength parameter fit from the compressive strength tests (MPa), s is a fit parameter 



(hrs), and s is a fit parameter.  Equation 52 is not very good for use in thermal stress 

analysis, because before setting, the compressive strength is zero.  Any modulus value 

calculated from the compressive strength which is equal to zero will result a singular 

matrix in the structural analysis.  Equation 53 is only allowed to be used in 

ConcreteWorks when the Nurse-Saul maturity method is used.   

Elastic Modulus Development 

The elastic modulus provides the link between restrained strains and stresses.  The elastic 

modulus is known to be dependent on the mixture proportions, unit weight, maturity, 

aggregate modulus, strength, and moisture condition.  The elastic modulus is known to 

develop faster than the tensile and compressive strength.  Several models for the elastic 

modulus development with time are based on a form of Equation 54: 

)(*)( tEtE ref  Equation 54 

where Eref is the reference modulus (MPa), E is the elastic modulus at time t, and  is a 

modification factor that accounts for the modulus development with time.  Equation 55-

57 for  are compared to experimental data (Larson, 2003): 
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where ts is the apparent setting time (hours); b1, b2, , , and s are model parameters; tB

is a constant that represents the time of change in slope of the elastic modulus (hours); 

and E  is the ultimate elastic modulus (MPa).   Larson (2003) found that all three models 

gave satisfactory results when elastic modulus data from concrete less than one day old 

was used in the model parameter regression analysis. 

Rostasy, Gutsch and Laube (1993) have proposed a model for the normalized 

modulus development based on degree of hydration as shown in Equation 58: 
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where Ê is the normalized elastic modulus,  is the degree of hydration, and 0 is the 

degree of hydration at time of initial setting.   Bernard, Ulm, and Lemarchand (2003) 

found that the elastic modulus of cement paste increases almost linearly with the degree 

of hydration.  This is because the modulus development is highly dependent on the 

porosity of the cement paste. They found that when aggregates are added the relationship 

between elastic modulus and degree of hydration stops being linear. 

The elastic modulus is also commonly calculated from the compressive strength of 

the concrete.  Most models of this type follow a form of Equation 59: 

n
cfkE )(  Equation 59 

where fc is the compressive strength (MPa), and  k and n are model parameters.   ACI 318 

(2005) uses a form of this equation where n is equal to 0.5 and k is as shown in Equation 

60: 

5.1043.0 cwk  Equation 60 



where wc is the unit weight of the concrete (kg/m3).  ConcreteWorks uses Equation 59 

and Equation 60 in calculating the elastic modulus from the compressive strength 

development.  The default values set in ConcreteWorks are equal to those used in the 

ACI 318 building code.  This equation was chosen because most engineers are familiar 

with this equation from prior experience in structural design, and readily accept its use.  

Most ConcreteWorks users will also not have test data available to model the elastic 

modulus development, making the use of readily accepted default equations necessary.    

Tensile Strength Development 

Concrete failure in early age concrete stress models is usually considered to occur when 

the stress exceeds the concrete strength.  An accurate knowledge of the tensile strength 

development of concrete is just as crucial in determining concrete cracking risks as 

knowing the stress.  The tensile strength development of concrete is known to be effected 

by aggregate strength, smoothness, and size, saturation level, and cementitious materials. 

Tensile strength develops in a similar manner to the elastic modulus.  The tensile 

strength has been found to develop faster than compressive strength, but slower than the 

elastic modulus.  The elastic modulus is often related to the compressive strength by 

Equation 61 (Raphael, 1984): 

m
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where ft is the tensile strength (MPa), and l and m are fit parameters. 

The tensile strength of concrete can be determined by uniaxial tensile tests, the 

splitting tensile test, or the flexural tensile test.  The uniaxial tensile test is difficult to 

perform especially at early ages.  The uniaxial tensile strength, splitting tensile strength, 

and flexural tensile strength of concrete have been found to develop at the same rate, 



allowing conversion from the splitting tensile and flexural tensile strength to the uniaxial 

tensile strength (De Schutter and Taerwe, 1996).  Rostasy, Gutsch, and Laube (1993) 

have shown that the tensile strength development is independent of the load history, 

allowing for independent calculation of the strength and stress.  ConcreteWorks assumes 

that the splitting tensile strength is used, and uses the parameters developed by Raphael 

(1984) of l equal to 1.7 and m equal to 2/3 for the default values.   

4.2.2. Poisson Ratio 

Stress modeling in two or three dimensional elements requires the knowledge of 

Poisson’s ratio.  There is debate as to whether Poisson’s ratio is constant or changing in 

young concrete.  Oluokun, Burdette, and Deatherage (1991) have concluded that 

Poisson’s ratio is independent of the age of the concrete.  This conclusion is not 

supported by their data, which shows the Poisson ratio at 6 hour to be less than that at 

later ages.  To illustrate why the Poisson ratio of concrete must not be a constant value, 

consider the concrete fresh plastic state. The Poisson ratio of concrete while the concrete 

is in its liquid state must be equal or close to that of water, 0.5.  After setting, the 

cementitious system stiffens and transforms from a suspended liquid to a rigid skeleton.  

The long term Poisson ratio of concrete varies between 0.15 and 0.2 (Mindess, Young, 

and Darwin, 2003).  A transition from a Poisson ratio of 0.5 to around 0.2 must occur 

during hardening.   

There are three models that describe how Poisson’s ratio changes with time.  The 

first model assumes a linear decrease in Poisson’s ratio with time.  Experimental data has 

shown that with concrete the Poisson ratio decreases to a minimum value before rising 

slightly to its final long term value (De Schutter and Taerwe, 1996).  This is the second 



model.  Byfors suggests that the Poisson ratio changes from 0.48 during the plastic state 

to 0.13 at a strength 1 to 2 MPa, to a final long term value of around 0.28 (De Schutter 

and Taerwe, 1996; Byfors, 1980).  Bernard, Ulm and Lemarchand (1994) suggest that 

during the plastic state, the continuous water structure dominates the Poisson ratio.  As 

the concrete begins to set, the water structure becomes discontinuous, decreasing the 

component of Poisson’s ratio supplied by the water structure.  During setting, the 

concrete microstructure begins to form, increasing the component of the Poisson ratio 

supplied by the solid skeleton.  The sum of the components of the Poisson ratio results in 

a minimum value during setting which increases to a stable long term value as shown in 

Figure 38. (Bernard, Ulm, and Lemarchand, 2003).  De Schutter and Taerwe (1996) 

proposed a model for the Poisson ratio  based on the degree of hydration, as shown in 

Equation 62: 

rerr 105.0
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where r is the degree of hydration.  ConcreteWorks uses this model because the model 

captures the shape of Poisson’s ratio development and because of the model’s simplicity. 
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Figure 38 - Poisson ratio development during hydration

The third model is based on the composite sphere model.  Poisson’s ratio is calculated 

form the bulk modulus K and the shear modulus G of the concrete as shown in Equation 

63.  Paulini and Gratl (1994) conclude from this model that Poisson’s ratio does not reach 

a minimum value and then increase, but steadily decreases to an asymptotic value.  

Bernard, Ulm and Lemarchand (2003) on the other hand, use Equation 63 to support the 

second model by suggesting that the bulk modulus and shear modulus change at different 

rates.  The ratio of the shear modulus to bulk modulus increases to a maximum value and 

then declines.     

GK
GK

26
23  Equation 63 

Poisson’s ratio has been found to be equivalent in tension and compression (Lydon 

and Balendran, 1986).  This is a very important point for use in computer models of 



thermal stresses.  ConcreteWorks assumes that the Poisson’s ratio is equal in 

compression and tension. 

The dynamic Poisson ratio is about 25-40% higher than the static Poisson ratio 

(Byfors, 1980).  The dynamic Poisson ratio is thought to be more representative of the 

actual elastic behavior of concrete (Mindess, Young, and Darwin, 2003).  The static 

Poisson’s ratio has been found to be principally a function of the percent volume of 

aggregates in the mixture, while the dynamic Poisson’s ratio has been found to be a 

function of the age, w/cm, and percent volume of aggregates.   

Poisson’s ratio has been shown to be constant up to a stress of 50 – 60% of the 

compressive strength.  Micro-cracking at higher stress levels can change the Poisson’s 

ratio.  Poisson’s ratio may also be different under biaxial or triaxial states of stress 

(Anson and Newman, 1966).  ConcreteWorks assumes that the Poisson’s ratio is 

independent of the stress level and the state of stress. 

4.2.3. Coefficient of Thermal Expansion 

The coefficient of thermal expansion (CTE) of concrete is one of the most important 

parameters in predicting stress distributions in concrete members.  Knowledge of the 

CTE allows researchers to separate the effects of temperature induced deformations from 

autogenous shrinkage in laboratory tests.  Separate models for thermal and autogenous 

deformations can then be made, allowing for their superposition in computer based stress 

models.  There are several factors which can affect the CTE including: mixture 

proportions, aggregate type, degree of saturation, and age.   

The hardened concrete CTE is primarily a function of the coefficient of thermal 

expansion of the concrete mixture’s constituent materials (Mitchell, 1953; Emanuel and 



Hulsey, 1977).  Because of the volume of aggregates in concrete mixtures, the hardened 

concrete CTE is dominated by the CTE of the aggregate.  Some common values of the 

CTE for concrete containing different types of aggregates are shown in Table 8.  A 

change in the cementitious material properties such as fineness, type, and composition 

will also affect the CTE (Mitchell, 1953). 

Table 8 - Coefficient of thermal expansion for concretes made with different 
aggregates (Bamforth and Price, 1995) 

Aggregate Type of Concrete 
Coefficient of Thermal Expansion 
(m/m/°C) 

Siliceous River Gravel 12.0 
Granite 10.0 
Limestone 8.0 
Lightweight 7.0 

 
Materials change volume as the temperature changes because the temperature 

changes the attractive forces in molecular and atomic structures, as well as capillary 

stresses.  It has been observed that concrete has a higher CTE when partially saturated 

then at oven dry or saturated.  The CTE reaches a maximum value between 60 and 80% 

relative humidity (Meyers, 1950; Mitchell, 1953; Emanuel and Hulsey, 1977; Walker, 

Bloem, and Mullen, 1952).  As the water in capillary pores expands with temperature, the 

surface curvature and hence surface tension and capillary under pressure in the pores 

decreases.  This surface tension induced volume change does not occur at oven dry 

conditions or at saturated conditions because the pore has no air-water meniscus in these 

states (Bjøntegaard, 1999).  When autogenous shrinkage occurs in concrete, the relative 

humidity will drop in the capillary pores to a limiting value of about 75% (Jensen and 

Hansen, 2001).  The CTE will then rise because of the change in relative humidity 

(Hedlund, 2000), further increasing the development of thermal stresses. 



Some researchers have found different coefficients for thermal expansion and 

contraction (Byfors, 1980; Emborg, 1989).  The difference in measured coefficients may 

be explained by the changing mechanical properties of concrete during young ages, so 

that the concrete that is measured during the heat phase is different mechanically than 

that measured during cooling a short time later (Emborg, 1989).  Differences between 

measured coefficients of thermal expansion and contraction may also be due to non-linear 

effects from differences in the CTE between the concrete and embedded strain gauges 

(Yamakawa, Nakauchi, Kita, and Onuma, 1986).  

As the concrete hydrates, the coefficient of thermal expansion will change.  The fresh 

concrete CTE is estimated to be 8-10 times greater than the hardened CTE (Schöppel and 

Springenschmid, 1994).  There is debate about how the CTE changes during hydration.  

Kada, et. al. (2002) measured a decrease in the CTE for a low w/cm mixture (0.30) 

during the first few hours after setting.  The CTE then increased to a stable long term 

value.  Mixtures with a w/cm of .35 and .4 both showed the CTE decreasing to assume a 

stable value at around 10 hours.  The drop in the CTE and subsequent rise can be 

attributed to the reduction of relative humidity in the sample because of self desiccation, 

which increases the CTE.  Other researchers have found that the CTE decreases to an 

asymptotic long term value (Byfors, 1980; Glisic, 2000).  Hashida and Yamaziki (2002) 

have developed an equation to relate the time of final set to the coefficient of thermal 

expansion, as shown in Equation 64: 
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where cte is the concrete coefficient of thermal expansion ( /°C), a1 and b are fit 

parameters ( /°C), t is the time, and tfs is the time of final set.  The parameters a1 and b 

are dependent on the w/cm, supplementary cementitious materials, cement type, and 

aggregates used.   

ConcreteWorks uses a constant CTE, because of the lack of a data to model how the 

mixture proportions relate to CTE development.  Because the CTE decreases very rapidly 

before the time of set, little loss in accuracy is expected from using a constant value 

except in the case of low w/cm where the CTE may increase after set and during curing.  

The constant coefficient of thermal expansion used in ConcreteWorks is calculated from 

the mixture proportions and the aggregate type using the method proposed by Emanual 

and Hulsey (1977) shown in Equation 65. 
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where cteh is the hardened concrete CTE, ca is the coarse aggregate CTE ( /°C), Vca is 

the coarse aggregate volume (kg/m3), fa is the fine aggregate CTE ( /°C), Vfa is the 

fine aggregate volume (kg/m3), p is the paste CTE ( /°C), and Vp is the paste volume 

(kg/m3).  In order to simplify the inputs, ConcreteWorks uses the assumed material 

specific gravity values for constituent materials shown in Table 9 in calculating the 

hardened concrete CTE.  The assumed constituent material CTE values are shown in 

Table 10.  Material coefficient of thermal expansion and specific gravity values can vary 

substantially, and may affect the calculated coefficient of thermal expansion value 

substantially.  The values selected for use in ConcreteWorks were selected to represent 

typical, commonly used Texas materials.  For more accurate results, it is suggested that 



the user test and input into ConcreteWorks the hardened concrete CTE of the specific 

materials used.   

Table 9 - Concrete constituent materials assumed specific gravity values
Material Specific Gravity 
Water 1 

Cement 3.14 
Class F Fly Ash 2.4 
Class C Fly Ash 2.7 

Slag 2.87 
UFFA 2.57 

Silica Fume 2.2 
Coarse 

Aggregate 2.65 
Fine Aggregate 2.65 

 
Table 10 - Concrete constituent materials assumed CTE

Material 

Coefficient of Thermal 
Expansion values used in 
ConcreteWorks ( /°C) 

Coefficient of Thermal Expansion 
from Emanuel and Hulsey, 1977 

( /°C) 
Hardened Cement Paste 10.8 10.8 

Limestone Aggregate 3.5 3.5 - 6 
Siliceous River Gravel 

and Sand 11 11 – 12.5 
Granite Aggregate 7.5 6.5 – 8.5 

Dolomitic Limestone 
Aggregate 7 7 - 10 

4.2.4. Autogenous Shrinkage Model 

ConcreteWorks uses a modified version of the autogenous shrinkage model developed by 

Hedlund (2000).  Hedlund developed a model based on his testing and that found in the 

literature for autogenous shrinkage starting at 24 equivalent age hours.  The model is 

based on an ultimate autogenous shrinkage calculated from the w/cm which is altered to 

account for temperature effects.  Equation 66-69 show the equations proposed by 

Hedlund for calculating the autogenous shrinkage with the concrete equivalent age: 
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Where ts0 (days), ts1 (days), SH, a0, a1, a2, b1, b2, T1 (°C), and T2 (°C) are fit parameters.  

Hedlund recommends setting the parameters ts1, SH, a0, a1, b1, b2, T1 (°C), and T2 (°C) 

may be set equal to 5 days, 0.3, 0.4, 0.6, 9 °C, 2.9, 55 °C, and 7, respectively.  

Additionally, he recommends setting the parameter a2 may be set equal to 1.3 for normal 

strength concrete and 0.1 for high performance concrete.  The parameter ts0 is the time at 

which the concrete shrinkage begins.  Before this time, the concrete autogenous 

shrinkage is set equal to zero (Hedlund, 2000).   

The autogenous shrinkage model used in ConcreteWorks modifies the model 

developed by Hedlund to reduce the w/cm at which autogenous shrinkage develops, the 

time at which autogenous shrinkage begins, and does not include the temperature 

modification term.  The ultimate concrete shrinkage value used in ConcreteWorks is 

calculated using Equation 70: 

310/238.294.0 cmwault  Equation 70 

The w/cm ratio at which autogenous shrinkage develops in ConcreteWorks is 0.42, which 

corresponds to the theoretical w/cm at which complete hydration is possible (Mindess, 

Young and Darwin, 2003).  Additionally, autogenous shrinkage begins at the virtual time 



of set, not at 24 equivalent age hours as in the Hedlund model.  The autogenous shrinkage 

model will be improved in future versions of ConcreteWorks as more data and models 

become available.   

4.3. Elastic Stress and Degree of Restraint 

The restraint is needed at each point in the concrete member at each time step to be able 

to accurately model the stresses in the concrete.  The restraint can be obtained by 

performing a structural analysis of the concrete member with non-uniform material 

properties across the cross section.  ConcreteWorks uses a plane strain finite-difference 

scheme to calculate the elastic stress in the member.  The software considers the non-

homogenous material development of the member by assuming a constant modulus and 

Poisson ratio for each control volume.  The elastic modulus and Poisson ratio for each 

control volume is different, and is based on the maturity for the case of the elastic 

modulus and the degree of hydration for the Poisson ratio.  The restraint case modeled for 

the rectangular column is the same as that shown in Figure 4, a 2-dimensional horizontal 

cross section of the column.  The restraint case modeled for the rectangular bent cap is 

the same as that shown in Figure 14, a 2-dimensional vertical cross section of the cap.  

Footings are modeled assuming a 2-dimensional cross section as shown in Figure 7, 

assuming a fixed base condition.  The state of stress in the rectangular column and bent 

cap can be adequately represented using the 2-dimensional models assumed because the 

stress in the third direction should be relatively small compared to the other two 

dimensions.  The footing model however may deviate from the actual member stresses 

because the stress in the third dimension may not be small relative to the other two 

dimensions.  Care should be taken in interpreting results from the footing model in 



ConcreteWorks.  Improvements in the footing elastic stress calculation module are being 

considered for future versions of ConcreteWorks. 

After the elastic stress is calculated, the elastic strain is then calculated using Hooke’s 

law, as shown in Equation 71-73. 
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Where x is the strain in the x direction, x is the stress in the x direction (MPa),  is the 

Poisson ratio, y is the stress in the y direction (MPa), y is the strain in the y direction, 

xy is the shear strain in the xy direction, xy is the shear stress in the xy direction, and E 

is the elastic modulus (MPa). 

4.4. Early-Age Concrete Creep Model

Creep is applied to the stresses in the x, y and xy directions independently.  The uniaxial 

constitutive equation for concrete creep is shown in Equation 74. 
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Where  is the total strain, t is the time, t0 is the time of the load application, J(t,t0) is the 

creep compliance, d (t0) is the stress imposed at time t0, and 0 is the instantaneous or 

elastic response to the stress application.   



 Creep is applied to the elastic strains using the principle of superposition.  The principle 

of superposition assumes that a step stress function is applied, with a corresponding strain 

response.  The strain responses are then superimposed using the assumption of linearity 

as shown in Figure 39.  The assumption of linearity is probably a valid assumption up to 

stress levels of about 40% (Emborg, 1998b).  The two obvious problems with the 

approach used in ConcreteWorks are 1) the thermal stresses calculated in the model can 

exceed 40% of the tensile strength and 2) the model assumes linearity.  The second 

assumption is a simplification necessary for simplicity and to reduce the runtime of the 

analysis.  This assumption is definitely not true.  Because the stresses in the member are 

relieved non-linearly by stress relaxation, the thermal stresses would redistribute in the 

member.  These assumptions however do not preclude ConcreteWorks from being used 

in design.  High tensile stresses should be avoided during the design stage to prevent 

damage from micro-cracking and potential through cracks.   

 



Figure 39 – Illustration of the principle of superposition

ConcreteWorks uses a modified version of the Linear Logarithmic Model for calculating 

the early-age concrete stress relaxation.  The Linear Logarithmic Model was developed in 

Sweden by Larson (2003) to model early-age concrete creep.  The method models the 

early-age concrete creep compliance function as a series or lines in log scale, as shown in 

Figure 40.  The slope of the lines can be calculated using Equation 75-78.  

 

Figure 40 – Creep Compliance modeled using the Linear Logarithmic Model (Larson, 2003)
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Where J( tload, t0) is the creep compliance (1/Pa), E(t0) is the concrete elastic modulus at 

the time of load application, J( tload, t0) is the change in creep compliance (1/Pa), tload 

, t1 is 

the time of the change in creep compliance slope (days), ts is the concrete time of set, 

ai
min, ai

max, tai, and nai are fit parameters.  ConcreteWorks assumes that the time of set 

occurs when the concrete reaches a compressive strength of 80 psi (Tuthill and Cordon, 

1955).   

 The Linear Logarithmic Model contains no creep compliance adjustment for 

changes in temperature.  It is well known that the creep rate increases at elevated 

temperatures (Emborg, 1998a).  The creep compliance can be modified by a temperature 

modification factor, as shown in Equation 79 (Emborg, 1998a): 

is the time since load application (days), t0 is the time of load application (days)

 ),()(),,( 00 ttJTTttJ c  Equation 79 

where J(t,t0,T) is the temperature adjusted creep (1/Pa), T is the absolute temperature (K), 

and c(T) is the creep modification adjustment factor.  ConcreteWorks uses a 



temperature modification factor based on the empirical temperature adjustment parameter 

suggested by Bažant and Panula (1978) as shown in Equation 80-84, where Equation 81-

84 come from Bažant and Panula: 
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Where CTMF is a fit parameter equal to 2.5, tT is the concrete age at the time the 

temperature is applied, w is the water content (kg/m ), cm is the cementitious materials 

content (kg/m ), a is the aggregate content (kg/m ), a1 is a constant that accounts for the 

type of cement used.   

r Estimates

he creep parameters used in ConcreteWorks are based on a statistical model developed 

from early-age rigid cracking frame tests on 36 different concrete mixtures.  A few of 

3

3 3

4.4.1. Creep Paramete

T



these mixtures were tested under several different temperature histories, in order to 

quantify the effects of temperature on concrete early-age creep.  The creep param ters ta1, 

ta2, and na2 are calculated from the concrete mixture proportions and constituent material 

properties according to Equation 85-87 when the Rietveld method (Rietveld, 1969) of 

determining the cement composition is used (Riding, 2007): 

e
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0265.00277.0988.72
Equation 87 

ass, perGypsum is the percent gypsum of the cement, as 

determ e is the percent hemihydrate in the 

cement, as determined by Rietveld analysis, perAnhydrite is the percent anhydrite in the 

cement, as determined by Rietveld analysis,  perAlite is the percent alite in the cement, as 

determined by Rietveld analysis,  and perAlum in the percent aluminate in the cement as 

determined by Rietveld analysis.  When a supplementary cementing material is used, the 

percent values used of the cement chemistry are the percent of the material in the cement 

times the percent cement of the total cementing materials.   

 

where perFA is the percent fly ash replacement of cement by mass, wcm is the water to 

cementing materials ratio, perFerrite is the percent ferrite of the cement, as determined by 

Rietveld analysis, perGGBFS is the percent grade 120 ground granulated blast furnace 

slag replacement of cement by m

ined by Rietveld analysis, perHemihydrat



When the Bogue method (ASTM C 150) of determining the cement composition is 

used, Equation 88-90 are used to relate the mixture proportions and constituent material 

properties to the early age MLLM creep parameters ta1 a2, na2 (Riding, 2007), t : 
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4

1

0119.0
)ln(459.00059.0743.0  

Equation 88 

 

AFperCSperC
wcmperGGBFSperFAta

42

2

0561.00189.0
463.3)(018.0464.3exp(  

Equation 89 

 

)0108.0583.0435.0
00494.0)(0597.0192.6exp(

43

2

CemBlaineAFperCAperC
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where perC AF is the percent C AF of the cement, as calculated using the Bogue method, 

perC S is the percent C S of the cement, as calculated using the Bogue method, perC A is 

the percent C A of the cement, as calculated using the Bogue method, cement is the total 

amount of cementing materials used in lb/yd3, and CemBlaine is the cement Blaine 

fineness in m2/kg.  When a supplementary cementing material is used, the percent values 

used of the cement chemistry are the percent of the material in the cement times the 

percent cement of the total cementing materials.   

The remainders of the MLLM creep parameters are kept constant, according to Table 

11: 

Table 11 – Modified Linear Logarithmic Model Parameters Assumed to Remain Constant in

Modified Linear 

Parameter Value Units 

t1 0.1 days 

a1 (*10^-12) 60 1/Pa  

4 4

2 2 3

3

ConcreteWorks

Logarithmic Model 

t0 0.001 days 

a1
min (*10^-12) 0.1 1/Pa  
max  



na1 1.19  
a2

min (*10^-12) 5 1/Pa 
a2

max (*10^-12) 30 1/Pa 

4.5. Cracking Potential

In ConcreteWorks, the cracking potential classification of a concrete member is based on 

the calculated tensile stress to tensile strength ratio.  The stress to strength ratio is 

compared against the cracking probability density calculated from the tensile stress at 

cracking to splitting tensile strength ratio from the rigid cracking frame tests.  Figure 41 

shows the cracking potential classification thresholds used on the cracking probability 

density function graph.   
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Figure 41 - Pro r Cracking Based on the Stress / Spl ensile Strength
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75% 5% cracking probability is assumed to be 

ConcreteWorks contains a chloride diffusion service life model for mass concrete and 

bridge decks.  The model is based on Fick’s second law of diffusion, as shown in 

Equation 91 (Incropera and Dewitt, 2002): 

 is assumed to be high, and higher than a 7

a very high cracking probability.  A lognormal distribution is used instead of a normal 

distribution because the tensile stress and splitting tensile strength are both positive 

quantities.    

 

5. Chloride Service-Life Modeling 

t
c

z
cD

zy
cD

yx
cD

x ccc  Equation 91 

Where Dc is the concrete diffusion coefficient (m2/s), and c is the chloride concentration 

(%).  Equation 91 assumes that the concrete is uncracked, saturated, the density is 

constant, and that diffusion is the only mass transport mechanism (the mass transport 

from any temperature gradient or pressure gradient is negligible).  A comparison of 

Equation 8 and Equation 91 show that the mechanisms for heat transport and mass 

transport are similar and may be calculated using the same numerical scheme.   

 The concrete service life can be modeled using a simplified corrosion damage 

model proposed by Tuutti (1982), as shown in Figure 42.  The concrete is assumed to be 

undamaged during a corrosion initiation period.  The corrosion initiation period ends 

when a threshold chloride concentration is reached, indicating that the protective steel 

passive layer has been broken down and corrosion has initiated.  After the corrosion has 



initiated, damage in reinforcing bars is assumed to occur linearly with time.  The 

propagation period for reinforcing bars is assumed to occur over a period of 6 years.     

restressed strand service life is assumed to end when the chloride threshold is reached 

because of the increased consequences of strand failure and higher rates of corrosion in 

P

the highly stressed strands. 

 

Figure 42 - Damage Model Used in ConcreteWorks Based on the Tuutti Model (1982)

The service life model used in ConcreteWorks assumes that the concrete is 

uncracked, and that the chloride ingress occurs only through diffusion.  The concrete 

structure service life will be lower than that predicted if joints are not properly sealed, 

cracks occur and are not sealed properly, if the service conditions or materials used differ 

significantly from thos used in the software inputs, or if the concrete is not cured 

properly.  Significant engineering judgement is needed in ensuring that the software 

results, including the software limitations are applied properly. 



5.1. Diffusion Coefficient

The diffusion coefficient for concrete changes as the concrete hydration progresses and 

the porosity decreases.  Both the total amount of porosity and the interconnectedness of 

the porosity play a significant role in concrete mass transport.  Concrete diffusivity will 

decrease as hydration progresses and the pore size distribution changes and the network 

of pores becomes more discontinuous.  This decrease in porosity and consequent 

diffusivity should decrease indefinitely; there is a limit to how much the concrete 

diffusivity can decrease. ConcreteWorks assumes that the concrete diffusion coefficient 

decays asymptotically to an ultimate value as shown in Equation 92-94 (Thomas, 2007 

personal communication).  The ultimate diffusion coefficient value is shown in Equation 

93.  Elevated temperatures will increase the chloride diffusion, and may be approximated 

using an Arrhenius type relationship.  The concrete diffusion coefficient is multiplied by 

and Thomas, 

200

an Arrhenius temperature adjustment term as shown in Equation 94 (Bentz 

1).   
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Where Dt(t) is the concrete diffusion coefficient (m /s) at time t (days), D28 is the 28 day 

concrete diffusion coefficient (m /s), m is the concrete diffusion decay constant, U is the 



diffusion process activation energy which can be assumed to 35000 J/mol, R is the 

universal gas constant (8.314 J/K/mol), Tref is the concrete diffusion coefficient reference 

temperature (293 K), and T is the temperature of the concrete (K).  Figure 43 and Figure 

44 show the effect of a change in the 28 day concrete diffusion coefficient D28 and the 

decay constant m on the concrete apparent diffusion coefficient. 
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Figure 43 - Effect of a Change in the Decay Constant m on the Concrete Apparent Diffusion

Coefficient Dt

D28=8x10
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Figure 44 - Effect of a Change in the 28 Day Apparent Diffusion Coefficient on the Concrete

Apparent Diffusion Coefficient Dt with Time 

reteWorks uses the yearly temperature profile calculated from the weather 

data files for the city selected in Equation 94.  The value for each temperature point used 

in the yearly temperature profile is calculated as the average of the 24 hourly temperature 

points for the day selected.  When the user selects 12 temperature points per year, the 12 

temperature data points are calculated using the first day of each month.  When the user 

selects 24 points per year, the 24 temperature data points are calculated using the first and 

fifteenth days of each month.  When the user selects 52 temperature points per year, a 

temperature point is calculated for every 7 days.   

All concrete bulk diffusion material models used in ConcreteWorks were 

developed by Mike Thomas based on tests performed according to ASTM C 1556.  There 

are many differences in reported chloride diffusion values in the literature because of 

 

Conc



differences in material, testing conditions, and analysis method.  Because the materials 

used were well characterized, the testing and analysis methods are known, and for 

consistency, only data collected at the University of Toronto and the University of New 

Brunswick was used in developing the concrete diffusion coefficient material models 

used in ConcreteWorks (Mike Thomas, 2007 Personal Communication).   

   Water to Cementitious Materials Ratio 

The water to cementitious materials ratio (w/cm) is a major factor in the chloride 

diffusion coefficient.  It is well known that the concrete porosity and consequently 

permeability decreases as the w/cm decreases (Mindess, Young and Darwin, 2003).  The 

base 28 day diffusion coefficient D28 used in ConcreteWorks is calculated using the w/cm 

as shown in Equation 95: 

279.0
/

12
cmw

28 1017.2 eD  Equation 95 

Figure 45 shows the test results from a study performed at the University of New 

Brunswick (UNB) and the University of Toronto (UT) used to model the affect of w/cm 

ratio on the concrete 28 day bulk diffusion value.  All of the tests shown in Figure 45 

were cast with a  type I cement with 12% C3A, with w/cm ratio varying between 0.2 and 

0.8, and cement contents varying between 225 and 725 kg/m3 (Mike Thomas, 2007 

Personal Communication). 
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5.1.1. Supplementary Cementing Materials

Supplementary cementing materials can reduce the diffusivity of concrete by reducing 

28 1040.51087.1 eD

 

Figure 45 - Relationship betw

the porosity and pore size distribution of concrete (Mindess, Young, and Darwin, 2003).  

Ultra fine fly ash and silica fume will reduce the 28 day diffusivity by particle packing 

and the pozzolanic reaction which will occur at a faster rate because of the high surface 

area.  The effect of ultra fine fly ash and silica fume on concrete 28 day diffusivity are 

calculated in ConcreteWorks using Equation 96 and Equation 97: 

07.6/829.0170.0 UFFA

PC

UFFA e
D

D
 Equation 96 

51.2/794.0206.0 SF

PC

SF e
D
D

 Equation 97 

Where DUFFA is 28 day diffusivity of concrete containing ultra fine fly ash (m2/s), DPC is 

the 28 day diffusivity of concrete containing no supplementary cementing materials 



(m2/s), UFFA is the percent replacement of cement with ultra fine fly ash, DSF is the 28 

day diffusivity of concrete containing silica fume (m2/s), and SF is the percent 

replacement of cement with silica fume.  The concrete diffusivity adjustments used for 

silica fume replacement are based on bulk concrete diffusivity tests performed using 

ASTM C 1556 using an immersion period of 35 days.  The concrete diffusivity 

adjustments used for ultra fine fly ash are based on bulk diffusivity tests using ASTM C 

1556 using an immersion period of 40 days.  Both silica fume and ultra fine fly ash 

testing was performed at the University of New Brunswick and the University of Toronto 

(Mike Thomas, 2007, personal communication).   

Fly ash will reduce the later age concrete diffusivity due to the pozzolanic reaction

diffusiv n why some fly ashes will 

he concrete diffusivity 

with time) is used in ConcreteWorks as shown in Equation 98: 

 

although there is no clear trend on the effect of fly ash on the young concrete (28 day) 

ity.  No model has yet been developed that can explai

increase the 28 day concrete diffusivity while other will decrease it.  Because of this 

inconsistency, fly ash is assumed to have no effect on the 28 day concrete apparent 

diffusivity.  Fly ash will however increase the reduction in the concrete bulk diffusivity 

with time, as modeled using the concrete diffusivity m parameter.  Ground granulated 

blast furnace slag will also increase the reduction in the concrete bulk diffusivity.  A 

linear increase in the m parameter (which consequently reduces t

7050
4.026.0 SGFAm  Equation 98 

where FA is the percent cement replacement with fly ash, and SG is the replacement with 

ground granulated blast furnace slag (Mike Thomas, 2007, personal communication).   



5.2.   Chloride Surface Concentration 

The chloride surface concentration is a major parameter in calculating the chloride 

concentration profile with time.  For relatively constant boundary conditions, such as 

marine exposure conditions, the surface concentration can be accurately modeled.  For 

structures such as bridge decks and parking garages, the surface concentration will vary 

dramatically even in the same structure.  The local conditions in the member may vary 

because of local differences in slope, proximity to drains, location relative to wheel paths 

and deicer salt application, and local variability in materials.  Chloride service life 

analysis can still be used as a design tool to compare the relative performance of different 

materials.  

5.2.1. Chloride Surface Concentration Buildup 

The concrete surface concentration will also change with time.  The concrete surface 

level will be higher during the winter when deicer salts are applied to the road, and lower 

in the summer and after rain storms wash away some of the salt.  A smooth curve may 

however be used as a good approximation of the seasonal surface chloride concentration 

build-up, as shown in the hypothetical surface chloride buildup and approximation in 

Figure 46.   
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Figure 46 ounting for Seasonal- Chloride Surface Concentration Versus Time with and without Acc
Variations
ConcreteWorks uses a smooth curve to approximate the surface chloride according to 

Equation 99: 

tb
tb

ss 1max  Equation 99 

where C

CtC )(

loride surface concentration, and b is the chloride surface concentration 

build-up rate constant.  The time t is not equal to zero at the time the concrete is placed, 

but at the age of the concrete when it is exposed to chlorides. 

The maximum chloride surface concentration and build-up rate constant for each 

city used in ConcreteWorks are stored in a data file in the application’s root directory.  

There are three possible structural classifications used in determining the maximum 

s(t) is the chloride surface concentration with time t (years), Csmax is the 

maximum ch



chloride surface concentration, Urban Bridge, Rural Bridge and Parking Garage, similar 

to those used in the software Life365 (Bentz and Thomas, 2001). If the city selected is 

near the ocean, the user will also have the option of selecting the structure to be in a 

marine splash zone, spray zone, within 0.5 miles of the ocean, and within 1 mile of the 

ocean.  The maximum chloride surface concentration and build-up rate constants used in 

ConcreteWorks for marine exposure are shown in Table 12.  ConcreteWorks uses the 

same maximum surface concentration values as found in the software package Life365, 

except for Florida.  The build-up rate constants used in ConcreteWorks were determined 

by fitting the initial slope of the smooth curve used in ConcreteWorks to the initial slope 

of the bilinear surface concentration build-up used in Life-365.  The build-up rate 

constant for a few of the cities available for selection in Texas were increased, while the

s.  In order to determine the build-up rate constant for cities in 

ConcreteWorks that were not available in Life365, the annual snowfall for each city was 

compared to that of other cities in the same state for which values were available in 

 
Table 12 

Splash zone 0.8 Instantaneous 

 

build-up rate constants for the Florida cities were decreased to better reflect the amount 

of deicer salt actually used.  Figure 47 shows the build-up rate constants used in 

ConcreteWork

Life365.  This is expected to give a reasonable approximation for these cities, because 

states usually have uniform deicer salting policies.  The maximum surface concentrations 

used for different exposure conditions corresponding to the build-up rate constant are 

shown in Table 13.   

- Chloride surface concentration constants used in ConcreteWorks for marine exposure 
Exposure 
condition 

Maximum 
surface 
concentration 
(%) 

Build-up rate 
constant 



Spray zone 1 0.15 

miles of ocean 

of ocean 

Within 0.5 0.6 0.06 

Within 1 mile 0.6 0.03 

 

 

 
Figure 47- Build-up rate constants used in ConcreteWorks

Table 13 - Build-up rate constants with their corresponding maximum surface concentration values
sed in ConcreteWorks

nt  Surfa
tration, C

um Surface 
ncentration, Csmax

Maximum Surface 
Concentration, Csmax

0.0045 0.8 0.68 0.56 
0.018 0.8 0.68 0.56 

0.8 0.68 0.56 

u
Build-up Rate Parking Garage Urban Road Rural Road 

Consta Maximum
Concen

ce 
smax

Maxim
Co

0.03 



0.04 0.8 0.68 0.56 
0.8 0.68 0.56 
0.8 0.68 0.56 
0.8 0.68 0.56 

1 0.8 0.68 0.56 
0.12 0.8 0.68 0.56 
0.14 0.8 0.68 0.56 
0.17 0.8 0.68 0.56 
0.20 1.0 0.85 0.7 
0.21 1.0 0.85 0.7 
0.24 1.0 0.85 0.7 

 

5.2.2. Membranes and Sealers 
Membranes are modeled in ConcreteWorks by using an equivalent time approach.  The 

equivalent age used in calculating the chloride surface concentration in Equation 99 is 

considered zero during the warranty period.  After the warranty period ends, the 

membrane is assumed to degrade during linearly.  The change in the surface chloride 

build-up equivalent age for a time step during the membrane degradation period is 

assumed to follow Equation 100: 
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 Equation 100 

Where tesc is the equivalent time for calculating the surface concentration (years), tewp is 

the time when the warranty period ends (years), tedp is the time when the degradation 

period ends which is equal to the warranty period plus the degradation period (years), t is 

 degradation period ends, the change
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percen ctive at the end he degradation period.  Sealers are assume e 100% 

effecti ain when reapplied.  Figure 48 shows a comparison of the chloride surface 

concentration build-up without a membrane or sealer, with a membrane, and with a sealer 

used. s case, the mem e is assumed to have a 10 year warranty period and a 10 

year d  period.  The sealer is assumed to have a 5 year degradation period and is 

reapplied every 5 years.   
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Figure 48 - Chloride surface concentration for cases where no barrier protection method is used, a

 

5.3

membrane is used, and a sealer is used

. Chloride Threshold

In ConcreteWorks, corrosion is assumed to initiate after the chloride concentration at the 

steel reaches a threshold value.  A one-size fits all corrosion threshold value is certainly 



not valid.  There are many different chloride threshold values published in literature.  

However, a comprehensive model for determining the chloride threshold value from the 

temperature, relative humidity, mixture proportions, and steel type used does not 

currently exist.  A single chloride threshold value that is dependent on the type of steel 

chosen is a reasonable assumption for design.  A chloride threshold value of 0.07% 

chloride by mass of concrete is used for black steel and epoxy coated steel (need 

references).  A chloride threshold value of 0.7% chloride by mass of concrete is used for 

grade 316 Stainless steel. 

ConcreteWorks contains inputs for two types of corrosion inhibitors, calcium nitrite 

based corrosion inhibitors or amines and esters.  ConcreteWorks uses the same chloride 

threshold values as Life365 when a corrosion inhibitor is used, as shown in Table 14.  

Corrosion inhibitors in ConcreteWorks are only used in the cast-in-place concrete.  This 

means that if the user selects a precast panel to be used with a bridge deck, the chloride 

threshold value of the steel in the precast panel does not change when a corrosion 

inhibitor is used.  In addition, like Life365 the diffusion coefficient is reduced by 10% 

and the chloride surface concentration build-up rate constant is also reduced by 50% 

when amines and esters is selected.  

0.15 
Calcium Nitrite at 15 L/m 0.24 

alcium Nitrite at 20 L/m3 0.32 
Calcium Nitrite at 25 L/m3 0.37 
Calcium 3

Am 2 
 

Table 14 - Chloride Threshold Values Assumed for Black Steel based on Corrosion Inhibitor Dose 
Corrosion Inhibitor and Dosage Chloride Threshold Value (% of Concrete) 
Calcium Nitrite at 10 L/m3

3

C

 Nitrite at 30 L/m 0.40 
ines and Esters at 5 L/m3 0.1



5.4. Initial Chloride Profile 

ConcreteWorks contains an option to model the chloride diffusion considering an initial 

chloride profile.  This initial chloride concentration profile may be used because of the 

addition of a significant amount of chlorides in the concrete mixture (such as the use of 

sea water instead of fresh water or the use of a calcium based admixture).  Additionally, 

the initial chloride profile may be used to enter the chloride profile obtained from 

performing chloride profile grinding of the actual structure.  Considerable engineering 

judgment should be used in performing this type of test and the subsequent service life 

ana

investigations.  Additionally, if corrosion has 

lysis.  Chloride profile tests can be highly variable depending on the location in the 

structure because of local water runoff conditions and local variability in the concrete 

cover quality.  When an existing structure is modeled, the age of the structure is added to 

the time used in determining the chloride surface concentration and the concrete diffusion 

coefficients.  The default chloride surface concentration constants should be altered to 

account for the actual concrete chloride surface concentration and the expected future 

concentrations.  This type of analysis should only be performed by those intimately 

familiar with the service life calculation methods used in ConcreteWorks and those with 

considerable experience in corrosion 

already initiated, it is not recommended to use ConcreteWorks to estimate the remaining 

concrete service life.   
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6. Getting Started 

6.1. Introductio

ConcreteWorks is a suite of Win chnology programs intended to 

be use miliar 

ith concrete materials and construction practices.  The first program in the series is the 

self-titled ConcreteWorks program.  ConcreteWorks is a concrete durability design tool 

that may be used to predict temperature development, thermal stress cracking probability, 

or the concrete chloride service life for various concrete members, as explained in the 

software introduction.  ConcreteWorks is meant to be used by operators described above 

that have a working knowledge of concrete behavior.  It is recommended that 

ConcreteWorks users thoroughly read the background information on the software to 

understand some of the limitations and the assumptions made in the software. 

Mix Proportions is a program that assists the user in concrete mixture design and 

proportioning.  Mix Proportions is based on the procedures outlined in ACI 211 (1991) 

and National Highway Institute (NHI) Course 15123 (Hover, 2003).   This user manual 

provides help and explanations on how to use the program ConcreteWorks.  No warranty 

of the accuracy of results calculated by any of the ConcreteWorks programs is given or 

implied.   

6.2. Installation 

To install ConcreteWorks, the target computer must be running the Microsoft .NET 

Framework v2.0.  The .NET Framework can be installed by running the program 

n To Using ConcreteWorks 

dows®-based concrete te

d by engineers, researchers, inspectors, contractors and precasters already fa

w



dotnetfx.exe.  The program dotnetfx.exe can be downloaded for free from the site 

wnloads/details.aspx?FamilyID=0856eacb-4362-4b0d-http://www.microsoft.com/do

8edd-aab15c5e04f5&displaylang=en 

The system requirements needed to install dotnetfx.exe can be found at:  

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-

8edd-aab15c5e04f5&displaylang=en#Requirements 

Once the target computer is running the .NET Framework, you may install 

ConcreteWorks. To install ConcreteWorks from CD, start by inserting the ConcreteWorks 

CD.  The computer should automatically detect ConcreteWorks, and open the Installation 

Wizard.  If the computer does not automatically start the installation process then open 

The “My Computer” window.  Next, open the folder of the CD containing 

ConcreteWorks.  Then double click the Setup icon.  The program should then start the 

Installation Wizard.  To install ConcreteWorks from a zip file downloaded from the 

internet, first unzip the file.  After the file has been unzipped, click run when prompted to 

open up the installation wizard. 

The installation wizard will guide you through all of the necessary steps to install 

the ConcreteWorks suite of programs.  The first screen is the installation welcome screen.  

Click the Next button to continue with the installation.  The second screen contains the 

End-User License Agreement (EULA).  Click the I Agree button if you agree with the 

terms of the EULA, and then click Next.  If you do not agree with the terms of the EULA, 

nd then Cancel, ending the installation process.  The software will click I Do Not Agree a

not install unless you signify that you agree to the terms of the EULA by clicking I 

Agree.  The next screen contains four check boxes corresponding to states, as seen in 



Figure 49.  The installation wizard will install the weather files of all the states whose 

corresponding box is checked.  As explained in Section 7.2.4, inputting the closest city to

the construction project is essential to accuracy of the program

 

 calculations. 

 

Figure 49 - Installation screen three, which weather files to install

Internet Explorer is required to be installed on the computer to access the official 

ConcreteWorks website from ConcreteWorks as described in Section 9.7.1.  Failure to 

have Internet Explorer installed on the computer could result in an error and/or the 

program crashing.  



Adobe Reader® is also required to be installed on the computer to access the 

ConcreteWorks User Manual as described in Section 9.7.2.  Failure to have Adobe 

Reader® installed on the computer could result in an error and / or the program crashing. 

6.3. Navigating the Program 

There are two methods of opening a new or saved file in ConcreteWorks.  The first 

method is to click on the New File or Open Existing File toolbar button.  The second 

method is to click New or Open under the File Menu.  Figure 50 shows a zoomed in view 

of the upper left side of ConcreteWorks.  The red arrows point to the different menus and 

toolbars available in ConcreteWorks.  If a file is already open, the program will prompt to 

save the current file.  If the Yes button is clicked, the program follows the save procedure 

outlined in Section 9.4.  If a file is not already open, the program will prompt the user for 

a filename and location, as described in Section 9.3.   



 

Figure 50 - Close up view of toolbars and menus

There are also two methods of changing the current input/results screen in 

ConcreteWorks.  The navigation toolbar found at the top of the program allows the user 

to quickly navigate between input/results screens.  Each button when clicked, displays the 

corresponding input/results screen.  Clicking on the Next button displays the next 

chronological input screen.  Clicking the Back button displays the previous screen shown.  

The navigation toolbar shows the order the screens are displayed.  

 



For more information on the printing features found in the File menu, see Section 9.1.  

See Section 9.6 for more information on the Tools menu and Section 9.7 for more 

information on the Help menu. 

7. Inputs 

7.1. Member Type 

When a new file is selected, the user is prompted to select the type of member to analyze.  

In ConcreteWorks v2.0, the user may select from four basic types of concrete members: 

mass concrete, bridge decks, pavements, or precast beams.  The analysis options 

available for each type of concrete member is shown in Table 1 of the introduction, 

section 0.  The input screens available will depend on the type of member selected, and 

will only be shown if needed.  For example, the Corrosion Inputs screen is not available 

when the user selects the Precast Concrete member type because ConcreteWorks does 

not contain a chloride service life module for precast beams.  The inputs for all member 

types will be explained together in the manual with the implication that if the input is not 

ill simply not be shown in the software.  

The basic model settings and project inputs are all done in the General Inputs screen, as 

seen in Figure 51.  The General Inputs screen is the first screen shown after opening a 

applicable for a particular member type, it w

Additionally, the next and back buttons will show the next input screen available in the 

same order as the order of inputs shown in the input screen navigation toolbar shown in 

Figure 50. 

7.2. General Inputs 



new or saved file, which is why there’s not a Back button shown.  Changing the inputs in 

the General Inputs screen will fundamentally change other data entered later in the 

program.  Changing the placement date, analysis duration, or project location will cause 

the weather data to change, even if maximum or minimum values have been entered 

earlier.     

 

Figure 51 - General Inputs screen

7.2.1. Units 

There are many inputs in ConcreteWorks that can be entered in either English units or 

 English units system is the default units system in 

ConcreteWorks.  When the system of units is changed, the program will prompt the user 

to change all values or cancel to stay in the current unit system.  If the user chooses to 

change the values entered, the program assumes that the user entered the correct values 

Metric (S.I.) units.  The



for the old unit system, and will then multiply the entered values by the appropriate 

conversion factor for the new unit system.  The Chloride Units input allows the user to 

select to perform the chloride service life calculations by % Chlorides by mass of 

concrete, or by mass per unit volume.  The chloride surface concentration inputs in the 

Corrosion Inputs will be in the units chosen, as will the steel chloride threshold at 

corrosion initiation values, and the initial chloride concentration values.   

7.2.2. Project Time and Date 

The Placement Time box allows the user to enter the time concrete placement is started 

on the element being analyzed.  If the cross-section being analyzed is a horizontal cross-

section (such as a column), then the user should input the time concrete is placed at the 

particular cross-section being analyzed.  The default time is 7:00 a.m. 

The Placement Date is entered by clicking on the number corresponding to the 

date of concrete placement.  The month or year of placement can be changed by either 

clicking on the appropriate arrow or by clicking on the month or year.  The default date is 

the current date.   

Accurate results in ConcreteWorks depend on the user entering the correct time

mum and maximum weather data is entered later in the 

rrect date and time must still be entered.  The shape of the weather data 

 

and date.  Even if the mini

program, the co

plots are extracted from thirty-year average data.  Because of the changing sunrise and 

sunset times, every day has fundamentally different shape of the weather data plot.  

Entering the correct maximum and minimum weather data later in the program will give 

the correct overall magnitude for the weather data plots, but will not change the weather 

data’s fundamental shape. 



7.2.3. Analysis Setup 

ConcreteWorks predicts the temperature development of a concrete cross-section for the 

number of days selected under the Analysis Duration option.  The default number of days 

is seven.  The Chloride Service Life Analysis Duration input allows the user to select the 

number of years that are used to calculate the chloride ingress into the concrete.  If the 

steel chloride threshold has not been exceeded during the time period selected for the 

ation, then the results will show that the time to 

corrosion initiation will be greater than the Chloride Service Life Analysis Duration.   

wn list of cities to 

select t

s are located in the same folder as the ConcreteWorks application.  

Weathe

Chloride Service Life Analysis Dur

7.2.4. Project Location 

Under the Project Location option, the user should select the closest city to the 

construction site that has a similar climate.  Besides using the drop-do

he project location, cities in the currently selected state can be selected by clicking 

on the city name in the city map.  When installed, ConcreteWorks automatically installs 

weather data files for seventeen Texas cities (as shown on the map on the General Inputs 

screen).  The file

r files for states other than Texas may be installed during the installation process.  

This is done by checking on the box corresponding to the state desired found on 

installation screen 3, as seen in Figure 49 and described in Section 6.2. Weather files for 

other cities will also be detected automatically and added to the available cities list by 

placing a copy of the weather file in the same folder as ConcreteWorks.  ConcreteWorks 

automatically detects all weather files located in the same folder as ConcreteWorks, and 

adds them to the drop-down list of available cities.  Caution: only genuine 



ConcreteWorks weather files can be recognized by ConcreteWorks.  Other weather files 

ConcreteWorks can predict the temperature distribution for several types of mass 

concrete elements.  All available concrete shapes available according to the type of 

concrete member selected are listed in the Shape Inputs screen.   

 of predicting temperature development in six unique 

mass concrete member types, four types of bridge decks, and four precast beam shapes.  

ConcreteWorks also has a pavement temperature prediction built in, but because there is 

only one concrete pavement type allowed, the shape inputs screen is not shown when 

pavement member types are selected.  The shapes available were selected in cooperation 

with TxDOT engineers to reflect the most common types used in Texas.  Figure 52 shows 

the mass concrete shapes available in the Available Shapes frame.  Figure 53 shows the 

four types of bridge deck types available in the Shape Inputs screen, while Figure 54 

shows the precast beam types available.  When a shape is checked, a picture of the shape 

is shown to the right for confirmation.  Once the desired shape is selected, proceed to the 

next screen.   

may cause an error in the program. 

7.3. Shape Inputs 

7.3.1. Available Shapes 

ConcreteWorks has the capability



 

Figure 52 - Shape Inputs screen for mass concrete member types 



 

Figure 53 - Shape Inputs screen for bridge deck member types 



 

Figure 54 - Shape Inputs screen for precast beam member types

7.4. Member Dimensions

Each unique concrete cross-section type will display a different picture and inputs on the 

Member Dimensions screen.  All shapes however, use the same basic format.  Figure 55 

shows the Member Dimensions screen for the Rectangular Column member. 



 

Figure 55 - Member Dimensions screen for the Rectangular Column element

the left side.  

Because the program’s focus is on transportation related concrete (bridges and 

pavements), ConcreteWorks limits the size of some member dimensions.  The 

Rectangular Column, Rectangular Footing, Partially Submerged Rectangular Footing, 

and Rectangular Bent Cap have minimum dimensions of three feet each.  The Circular 

Column has a minimum diameter of three feet.  The T-Shaped Bent Cap has a minimum 

seat height of nine inches and a minimum top width of 1.5 feet.  The overall cap height 

must also be 1.5 feet taller than the seat, and the overall cap width must be 1.5 feet 

7.4.1. Dimensions

Each shape will require the user to enter the member cross-sectional dimensions.  All 

dimensions input will correspond to the same dimensions on the picture on 



greater than the top width.  If an invalid dimension is entered, an error will appear when 

the user attempts to calculate the member temperature development using the Calculate 

Temperatures button on the Input Check screen.  Member dimension limits for decks and 

pavements are enforced by the numeric-up-down control used to input the dimension.  

The Overall Deck Thickness is limited to 14 in., while the Precast Panel Thickness are 

limited to 8 in.  The Pavement Thickness, Subbase 1 Thickness, and Subbase 2 Thickness 

are all limited to 24 in. 

Pavement analysis are broken up into different layers with different material 

properties, as shown in Figure 56.  Users may select up to two types of subbase materials, 

in addition to the pavement and subgrade.  The subgrade material is assumed to extend 

infinitely beneath the subbase layer(s).  Pavement layer dimensions and types are not 

changed in ConcreteWorks until the user clicks on the Re-Draw Pavement System button.  

 update, allowing the 

user to check the currently selected inputs.   

The figure to the right of the pavement dimensions inputs will then



 

Figure 56 - Pavement Dimensions Input Screen 

7.4.2. Submerged

Some of the available member types have the option of being submerged in water.  This 

means that the cross-section being modeled is completely immersed in water.  One 

example of when the submerged option would be selected is when a column is placed in a 

lake or ocean.   

7.4.3. Soil on the Sides 

Some member types have the option of modeling soil on the sides of the member.  This 

option is selected when earthwork is used instead of formwork.  Figure 57 shows an 

example of the type of member that would have soil on the sides used instead of 

formwork.   



 

Figure 57 - Example of a footing that would use the Soil on the Sides option

a direction in a concrete member, the program assumes that there is no 

heat loss in that direction (i.e., perfectly insulated).  For example, with the rectangular 

lates the temperature profile of a horizontal cross-section of 

lumn.   

7.4.4. Cross-Sections analyzed

Temperature predictions are in some cases based on one or two-dimensional cross-

sections of the member.  When ConcreteWorks does not calculate the temperature 

distribution for 

column, ConcreteWorks calcu

the column.  The program assumes that there is no heat loss from the top of the column to 

the air or from the bottom of the column to the footing.  This assumption is a valid 

assumption for the vertical middle of the column, and becomes less accurate towards the 

ends in the co



When the user selects to analyze a rectangular footing or partially submerged 

rectangular footing in three dimensions, the temperature distribution in the footing is 

calculated for all three directions.  Calculating the temperature in three dimensions can 

give slightly better results in some cases, but significantly decreases the calculation run 

time.  The user only has the option of calculating the footing temperature in three 

dimensions when the user does not select soil on the sides of the footing.  When the user 

selects to calculate a two dimensional cross-section of the footing temperatures, as seen 

in Figure 58, the width side is used in calculations.  The length dimension entered is then 

ignored.  The user should enter the smaller dimension of the two horizontal footing 

dimensions in the width text box.   

 

Figure 58 - Rectangular Footing screen with Two Dimensional Analysis Selected 



7.4.5. Precast Panel Inputs

When the user selects a Generic User Defined Bridge on the Shape Inputs screen, then 

the user has the option of selecting to use a precast panel and the number of mats of steel.  

Figure 59 shows the Bridge Deck Dimensions Inputs screen when the Generic User 

Defined Bridge deck type is selected.  When the user selects to use two mats of steel and 

a precast panel, the bottom mat of steel is assumed to be made of prestressed strands.  

 

Figure 59 - Bridge Deck Dimensions Input Screen when the Generic User Defined Bridge Deck Type

is Selected 

7.5. Mixture Proportions

The Mixture Proportions screen is where the user inputs the concrete batch information, 

cement quantities separately, as if they were added to the concrete completely separate. 

as seen in Figure 60.  If blended cement is used, the user should enter the fly ash and 



 

 

Figure 60 - Mixture Proportion Inputs Screen when a Bridge Deck Member Type is Selected with 

Precast Panels

7.5.1. Mix Proportion Inputs

All information found in the Mix Proportion Inputs area must be inputted correctly for 

the program to generate a heat signature curve for the concrete.  Mixture information is

s per cubic meter for SI units).  The aggregate 

ggregate is saturated surface dry (SSD).  The water is 

 

entered by the amount of weight of a particular material for every unit volume (pounds 

per cubic yard for English units, kilogram

contents are entered assuming the a

entered based on total amount of free water available for hydration (aggregate moisture 

not absorbed + water/ice added).   

 



7.5.2. Supplementary Cementing Materials 

The Supplementary Cementing Materials (SCM) frame is where SCMs are input.  To 

include an SCM in the batch, check the box corresponding to the particular SCM.  Enter 

in the amount of SCM used in the batch.  The program defaults the free lime content of 

the ASTM Class C fly ash to twenty-nine percent and the ASTM Class F fly ash to 

nineteen percent.  These values can be changed if the free lime content of the fly ash used 

is known.  To remove the SCM from the batch, simply uncheck the corresponding box or 

set the amount used to zero. 

7.5.3. Calculated Mixture Proportions 

The Calculated Mixture Proportions frame displays calculated mixture ratios based on 

the current values entered.  The Sacks of Cement/volume quantity is based on the total 

number of 94 pound sacks of cementitious materials used in the batch (cement + SCMs) 

eter.  The number of Gallons of water per sack/liters per sack figure is 

the amount of water per sack of cementitious materials.  The density of the water is 

).  The Water/Cement Ratio is equal to the water 

 

per cubic yard/m

assumed to be 1g/cm3 (62.43 lb/ft3

content entered divided by the cement content.  The Water/Cementitious Ratio is equal to 

the water content entered divided by cementitious materials content. 

7.5.4. Chemical Admixture Inputs 

Chemical admixtures are entered by checking on the admixture.  To simplify mixture 

proportion inputs, typical values of chemical admixture doses are assumed as shown in 

Table 5. 

  



7.5.5. Bottom Panel Mixture Proportions 

When a bridge deck member type with precast panels is selected, the user may change the 

bottom panel mixture proportions by clicking the button Click to Change Bottom Panel 

Mixture Proportions.  When this button is clicked, an input screen similar to the Mixture 

Proportion Inputs screen is shown.  Figure 61 shows the Precast Panel Mixture 

Proportions Inputs screen that is displayed.  Here, the user may enter the mixture 

proportions used in the precast panel concrete.  There are two visible differences between 

the Mixture Proportion Inputs screen and the Precast Panel Mixture Proportions Inputs 

screen.  The first is the title shown on the blue form bar.  The second is that the button on 

the lower right hand corner is the Next button on the Mixture Proportion Inputs screen, 

while on the Precast Panel Mixture Proportions Inputs screen is the OK button.  The OK 

Although the precast panel is assumed to not generate any heat, the concrete diffusion 

button, when clicked, will return the user to the Mixture Proportion Inputs screen.  

coefficients used in the chloride service life analysis is determined from the concrete 

panel mixture proportions.   



 

Figure 61 - Precast Panel Mixture Proportions Inputs Screen 

If the user needs help with the concrete m

7.6. Concrete Mixture Proportioning

ixture design and proportioning, the user may 

click on the Go to Design of Mixture Proportion button on the lower right corner of the 

Mixture Proportions screen, as seen in Figure 60.  The Design of Mixture Proportion 

screen will appear, as seen in Figure 62.  The Design of Mixture Proportion screen guides 

the user through the mixture proportioning steps as found in ACI 211 (1991) and NHI 

Course 15123 (Hover, 2003).   For a more detailed presentation of the mixture 

proportioning procedure and limitations, please refer to ACI 211 (1991) and section 6 of 

this manual.  The most important thing to remember about the mixture proportion 

calculations is that they are only designed to create the proportions for making and testing 

a trial batch.  The calculations in the Design of Mixture Proportions screen can never be 



used as a substitute for local knowledge of material properties or for trial batches.  This is 

designed to be a user-friendly tool as the first step in designing mixtures for field 

applications. 

The Cancel button on the Design of Mixture Proportion screen sends the user 

back to the Mix Proportions Inputs screen without any changes being made to the 

material weights.  The OK button sends the user back to the Mixture Proportions Inputs 

screen, changing the material weights to those shown in the Final Volume Calculations.  

When a chemical admixture is checked in the Water Adjustment tab, the admixture is 

then checked on the Mix Proportions Inputs screen.  When the High-Range Water 

Reducer (Type F) box is checked in the Design of Mixture Proportion screen, 

ConcreteWorks assumes that a Napthalene-based admixture is used. 

 

Figure 62 - Design of Mixture Proportion Screen - General Mix Information Inputs



7.6.1. General Mix Information 

The General Mix Information tab of the Design of Mixture Proportion screen displays all 

of the general material specifications.  If not entered manually, the w/cm ratio is 

calcula

7.6.2. Aggregate Properties 

The Aggregate Properties tab allows the user to either input the aggregate properties or 

calculated some of the inputs needed from an aggregate sieve analysis.  Figure 63 shows 

the Aggregate Properties tab. Sieve Analysis Data for each aggregate type used should be 

entered as percent passing.  Additionally, the percent of each aggregate used should be 

input as percent of the coarse or fine aggregate used, not the total amount of aggregates 

used.  When the Update Agg. Properties button is clicked, the combined Coarse 

Aggregate Specific Gravity, combined Fine Aggregate Specific Gravity, and Maximum 

Size Aggregate inputs are updated.  Additionally, the aggregate gradation charts are 

updated when the Update Agg. Properties button is clicked. An error is generated when 

the user enters a percent passing value that is larger than that from a larger size sieve, 

when the sum of coarse aggregate percent used values does not equal 100 percent, or 

when the sum of fine aggregate percent used values does not equal 100 percent.   

ted from the Target Strength shown in the Strength Requirement frame, the air 

content, and any minimum w/cm ratios imposed by selecting a severe exposure condition 

from ACI 318-02 Tables 4.2.2 or 4.3.1. 

The target strength is calculated by default on the specified f’c increased by the 

percent increase in target strength value.  Alternatively, the user may calculate the 

concrete target strength by checking the box for using the concrete standard deviation, 

and then entering the standard deviation.   



 

Figure 63 - Aggregate Properties Tab on the Design of Mixture Proportions Inputs Screen 

7.6.3. Water Adjustment

The Water Adjustment tab contains tracking bars that let the user adjust the water 

requirements for the concrete by moving the tracking bar values, as seen in Figure 64.  To 

use a water reducer, check the corresponding box on the Water Adjustment tab.  Then 

move the track bar value to correspond to the water reduction gained from that particular 

admixture.  The values used for maximum and minimum water reduction for all factors 

come from the NHI Course 15123 (Hover, 2003).   A local knowledge of the water 

reduction properties for all the materials is extremely important.  The quality of the 

concrete mixture designed will depend greatly on the accuracy of the inputs.  Trial 

batches should always be made to verify the slump and strength properties of the 

concrete.   



 

The Adjusted Water Content shown in the Paste Content frame is calculated based on the 

desired slump, the percent air, the aggregate gradation, and any water requirement 

adjustments made in the Water Adjustment tab (as described in Section 7.6.3).  The 

cementitious material content is calculated by dividing the Adjusted Water Content by the 

w/cm ratio.   

 

 

Figure 64 - Water Adjustment tab on the Design of Mixture Proportion screen 

t, and air content.   The batch weights per yard of concrete are shown in the 

7.6.4. Final Volume Calculations

The final volume calculations for the concrete mixture are calculated based on the 

aggregate properties, cement content, adjusted water content, mineral admixture 

replacemen



Final Weights frame.  The pie graph shows the percent of each material in the concrete 

h a high surface area-to-volume ratio when exposed to low relative 

umilities. 

mixture by volume.  Figure 65 shows the Final Volume Calculations tab.  When the total 

calculated paste content exceeds 30% by volume a warning appears to warn the user that 

the concrete mixture may be more susceptible to drying shrinkage.  This does not 

preclude the use of the concrete mixture, but caution should be used for concrete 

members wit

h

 

Figure 65 - Final Volume tab of the Design of Mixture Proportion screen

7.7. Material Properties

The material characteristics are entered in the Material Properties screen.  Figure 66 

shows the Material Properties screen.  To manually override the default cement 



chemistry and hydration parameters, check the corresponding boxes and enter in the 

desired values, as seen in Figure 67.   

 

Figure 66 - Material Properties screen 



 

Figure 67 - Material Inputs screen with manual adjustment checkboxes checked

7.7.1. Cement Chemical/ Physical Properties 

The Cement Chemical/Physical Properties frame is where the cement type, composition 

and physical properties are entered.  To change the cement properties to those for the 

cement used, check the Check to manually enter cement chemical/physical properties 

box.  If the user unchecks the Check to manually enter cement chemical/physical 

properties box, the cement properties revert back to the default values for the cement type 

selected.  When the Bogue method is selected under the Cement Analysis Method found 

in the Tools menu, the Bogue values and oxide contents for the cement properties are 

displayed.  If the Rietveld method is selected instead of the Bogue method, then the 

cement composition phases corresponding to that method is displayed.  Actual cement 



properties estimated using the Bogue method can be found on mill sheets shipped with 

the cement.   

7.7.2. Hydration Calculation Properties 

Hydration Calculation Properties are based on equations developed as part of Texas 

Department of Transportation (TxDOT) research project 0-4563, and are described in 

section 3.1.5.  Different models that describe the Hydration Calculation Properties are 

used depending on whether the Bogue method of the Rietveld method is used to define 

the cement properties.  If the user has performed a semi-adiabatic calorimetry test on the 

concrete mixture used, then the calculated hydration properties can be changed by 

checking the Check to manually enter hydration properties box.  When the Check to 

manually enter hydration properties box is checked, the hydration parameters do not 

i-

ation parameter equations for 

Choose the type of coarse and fine aggregates used in the concrete batch.  Up to three 

coarse aggregates types can be blended, while up to two fine aggregate types may be 

used.  The user may change the number of coarse aggregates blended by changing the 

change when the mixture proportions is changed or the cement type changes.  The sem

adiabatic calorimetry test performed to determine hydr

ConcreteWorks Version 2.0 came from mixes that used Texas materials.  Low alkali 

cements were used in a majority of tests, and thus the hydration parameters for any mix 

containing a large amount of alkalis may not be as accurate.  In the case that the concrete 

material properties deviate substantially from those used in Texas, a semi-adiabatic 

calorimetry test should be performed to determine the hydration parameters. 

7.7.3. Aggregate Factors 



number in the # of Coarse Aggregate Types drop down menu, and the number of fine 

aggregates blended by changing the number in the # of Fine Aggregate Types drop down 

menu.  When more than one type of aggregate type is selected to be blended, additional 

corresponding drop down menus will appear that prompt the user for the type of 

additional aggregate used.  The coefficient of thermal expansion (CTE) and material 

may be input by the user if a hardened concrete coefficient of thermal expansion test, 

 

The combined aggregate Cp value shown in Figure 66 is the Ca parameter shown in 

stresses calculated are very sensitive to the concrete coefficient of thermal expansion.  

Expansion and Thermal Properties is unchecked, the concrete CTE and thermal 

 of maturity 

eters as 

shown in Figure 68. 

thermal properties are calculated based on the mixture proportions and the coarse 

aggregate types.  The coefficient of thermal expansion and material thermal properties 

hardened concrete thermal conductivity test, or aggregate specific heat test is performed. 

Equation 24. It is highly recommended that the user perform a hardened concrete 

coefficient of thermal expansion test on the concrete mixture to be used as the thermal 

When the checkbox Check to Manually Enter the Concrete Coefficient of Thermal 

properties revert to default values as calculated according to the chosen aggregate types.   

7.8. Mechanical Properties Inputs 

The Mechanical Properties Inputs screen allows the user to input the type

method used, the maturity – strength relationships, and the early age creep param



 

Figure 68 - Mechanical Properties Inputs

7.8.1. Maturity Functions

The Maturity Functions frame allows the user to select between the Nurse-Saul method 

of maturity and the Equivalent Age method, both as described in ASTM C 1074.  For the 

Nurse-Saul method, a reference temperature of 0°C is used when metric units are selected 

en English units are selected.  If the user 

to calculate thermal stresses when temperatures are calculated 

checkbox must be checked for the software to calculate the concrete member cracking 

probability failure classification.  When thermal stresses are to be calculated, the 

equivalent age maturity method must be used.  The elastic modulus and splitting tensile 

and 0°F is used as the reference temperature wh

has a maturity curve already calculated for the given concrete mixture, the user may enter 

the a and b strength parameters according to the equation shown on the Materials Inputs 

screen.  The Check 



strength equations are calculated from the concrete compressive strength fit parameters 

entered.  At a minimum, the compressive strength – maturity relationship must be entered 

for the concrete mixture proportions and materials used.  The accuracy of the thermal 

cracking probability analysis increases when the elastic modulus and splitting tensile 

strength are measured and input in the software.   

7.8.2. Early Age Creep Parameters 

The concrete early age creep is calculated using the Modified Linear Logarithmic Model 

(MMLM) described in 4.4.  The early age creep parameters for the MLLM are calculated 

from the mixture proportions and material properties entered.  Different equations are 

used, depending on whether the Bogue method or the Rietveld method is selected as 

describe in section 4.4.1.   

7.9. Construction Inputs 

The Construction Inputs screen is where the construction related options are entered.  

Each type of concrete member will have different construction options to choose from.  

ConcreteWorks will automatically display the needed inputs based on the other options 

selected by the user such as member type or if the member is submerged.  Do not be 

alarmed if a particular set of inputs does not appear with the particular choices made.  If 

you change the member shape or submerged status, the available construction inputs will 

change.  Dramatically different results will be calculated for even small mistakes, such as 

the form type, or blanket insulation.  Figure 69 shows the Construction Inputs screen for 

a rectangular column.   



 

 

Figure 69 - Construction Inputs screen for a rectangular column 

The Estimated Placement Temperature is the temperature of the concrete when it arrives 

on the jobsite.  The concrete placement temperature can be calculated three ways.   

The first way is to click on the Calculate button.  After it is clicked, the Raw 

Material Temperature Inputs screen will pop up.  The temperature of the cementitious 

materials, aggregates, and water must be entered.  Aggregate moisture contents and 

absorptions must also be entered.  Optionally, ice may be entered if it is used in the batch.  

The OK button will not work until all of the required information is entered.  After all of 

the required information is entered and the OK button is clicked, the calculated placement 

temperature will be displayed in the Estimated Placement Temperature box.  

7.9.1. Concrete Placement Temperature



ConcreteWorks uses the ACI 305 model for predicting the fresh concrete temperature 

(ACI 305R, 1991).  When the Mixture Proportion inputs are changed, the predicted fresh 

concrete temperature will also change, if all of the required inputs are entered in the Raw 

Material Temperature Inputs screen.  Note:  If all of the required inputs in the Mixture 

Proportion Inputs screen are not entered, ConcreteWorks will not be able to calculate the 

fresh concrete temperature. 

The second way is to calculate the concrete placement temperature from the 

ambient temperature.  In this method, the concrete fresh temperature is estimated as the 

ambient temperature at the time of placement. 

The third way to enter the concrete placement temperature is to check the Check 

here to manually enter Fresh Concrete Placement Temperature box.  After the box has 

been checked, the user may enter the concrete placement temperature in the Estimated 

Placement Temperature box is checked, the value in the Estimated Placement 

tered by the user.   

The Co

Placement Temperature box. If the Check here to manually enter Fresh Concrete 

Temperature box will only change when manually en

7.9.2. Formwork 

ncrete age at Form Removal input requires the user to input the concrete age 

when formwork is removed (at the cross-section being analyzed), starting from the time 

the concrete was first mixed.  The form type and form color must also be input in their 

corresponding boxes.   



7.9.3. Surrounding Temperature 

If the element selected is a footing or the element is submerged, the Construction Inputs 

screen will have inputs for the soil temperature and water temperature.  The soil 

temperature refers to the average soil temperature for the time being modeled.   A good 

estimate of the soil temperature for most footings is the average of the maximum and 

minimum ambient temperatures during the time period in question.  The water 

temper

ure method box, 

ConcreteWorks assumes that no cure methods are used.  The user cannot check both the 

nd the White or Clear Plastic option at the same time.  If for some 

oving forms and applying the cure method is one hour. 

ature refers to the temperature of the water surrounding a concrete element.  For 

example, if a column was being placed in a lake, the user would enter the average lake 

water temperature for that time period.   

7.9.4. After Forms Are Stripped 

The After Forms Are Stripped area asks the user to input what kind of curing methods are 

applied to the member after the forms are removed.  ConcreteWorks requires the user to 

enter a time in the box Time between form removal and curing method applied if a cure 

method is checked.  If the user enters a delay time, but does not check a c

Black Plastic option a

reason, both types of plastic are used in construction, the user should check the type of 

plastic used as the outside layer.  All curing methods applied after forms are stripped are 

assumed to remain on the concrete member until the end of the analysis duration.  The 

default time between rem



7.9.5. Footing Inputs 

When a footing is selected as the member type, the Footing Inputs frame becomes visible 

on the Construction Inputs screen, as seen in Figure 70.  The input Type of footing 

subbase asks the user to select the type of soil or rock on which the footing is built.  If a 

plastic sheet is also used in curing, the user should select which color plastic is used.   If 

both types of plastic are used, the user should select the color of the plastic placed on top.  

The input Concrete age when cure blanket is placed is the number of hours between 

concrete placement time and when cure methods are applied (the cure methods applied to 

the top before form removal).  This input allows the concrete to set before placing the 

cure blankets on top of the footing.   

If the sides of the footing are shaded from the sun because of scaffolding or the 

ground, the user should check the input Footing Sides Shaded.   



 

Figure 70 - Construction Inputs screen shown when the rectangular footing member shape is chosen 

7.9.6. Bent Cap Inputs 

The user must select which type of form is used for the bottom of the bent cap.  This 

allows the user to use different forms for the sides and bottom of a bent cap.  For 

example, the user could select steel forms for the sides of the bent cap, and wood for the 

bottom.  If the user selects Precast Concrete for the bottom form of the cap, the Precast 

Concrete Section Thickness input box appears, as seen in Figure 71.  The default cap 

bottom form type is steel.  The default precast concrete thickness is two feet.  The 

Concrete age when cure blanket is placed is the number of hours between concrete 

placement time and when cure methods are applied (the cure methods applied to the top 

before form removal).  This input allows the concrete to set before placing the cure 

blankets on top of the bent cap.  If a plastic is used on top of the cure blanket before form 



removal, the user should select which color plastic is used.   If more then one color of 

plastic is used, the user should select the plastic placed on top.   

 

Figure 71 - Construction Inputs screen for a rectangular bent cap with pre-cast concrete selected as

the bottom form

7.9.7. Bridge Deck Inputs 

ConcreteWorks assumes that a cure blanket is used on top of bridge decks.  The user may 

additionally select to use a layer of plastic on top of blanket, the time the blanket is 

placed, and the concrete age when the the cure blanket is removed.  If wood forms are 

selected for the bridge deck, the user may additionally specify the concrete age at the 

wood form removal, as shown in Figure 72. 



 

Figure 72 - Bridge Deck Inputs when Wood forms are Selected

7.9.8. Precast Concrete Construction Inputs

 When the a tarp or blanket is used on the sides of the precast beam, the 

ket on the top and sides of the beam.  The software also 

ethod used as shown in Figure 

73. The other pavement curing options depends on the curing method selected, and may 

Precast concrete members allow the user to specify a tarp or blanket to be used on the 

member sides. 

same R-value is used for the blan

allows the user to select the subbase underneath the precast member, and the age when 

the cure method is started.  The cure method is assumed to end when the forms are 

removed.   

7.9.9. Pavement Construction Inputs

ConcreteWorks asks the user to input the type of cure m



ask the user for the application rate, the time of cure method application and removal, and 

the cure method color. 

 

Figure 73 - Pavement Construction Inputs

e 3 in2-hr-F/BTU for a thick, good quality cure blanket and 1 in2-hr-F/BTU 

for burlap or worn cure blankets.    

7.9.10. Blanket Insulation R-Value

The Blanket Insulation R-Value frame allows the user to select the R-Value of all cure 

blankets used during the concrete member construction.  The R-Value is a measure of the 

blanket’s thermal insulation.  A high R-Value indicates a good insulator.  Recommended 

R-values ar



7.9.11. Form Liners 

The Form Liners frame asks the user to input which sides of the member use form liners.  

The width and depth sides correspond to the width and depth sides input in the Member 

Dimensions screen.  ConcreteWorks assumes that the form liners are solid rubber 

reusable form liners (such as the Symons brand Elasto-Tex™3 form liner). 

7.10. Environment Inputs 

The Environment Inputs screen is where all weather inputs are entered.  All weather 

inputs are entered in tables that function similar to cells in a spreadsheet.  ConcreteWorks 

requires that the user enter one more day than the number of days selected for analysis.  

The first day entered is the day selected as for the project date.  Default values are the 

average thirty-year weather data for the days selected for each individual city.  When the 

user changes the Placement Date, Temperature Analysis Duration, or project location on 

the General Inputs screen, the environment inputs are automatically updated to the thirty-

year average values.  The environmental inputs will always be updated, even if the user 

er values manually.  Care should 

7.10.1. Temperature  

The maximum and minimum temperature for each day is shown in the table on the 

Temperature tab.  Default values can be overridden by checking the Check to manually 

                                                

checks the boxes to input maximum and minimum weath

be taken to manually input environment values last.  Clicking on the table headings will 

sort the table by the values of the column clicked on.  The overall data will not be 

affected by sorting the data.   

 
3 The Elasto-Tex™ trademark belongs to the Symons Co. 



enter temperature data input.  Next, click on the table cell desired, and change the 

maximum or minimum value.  Figure 74 shows the Environment Inputs screen with the 

Temperature tab selected.   

 

Figure 74 - Temperature tab on the Environment Inputs screen 

ult values can be overridden by checking the Check to 

manually enter humidity data box.  Next, click on the table cell desired, and change the 

maximum or minimum value.   

7.10.2. Relative Humidity

The maximum and minimum relative humidity for each day are shown in the table on the 

Relative Humidity tab.  Defa



7.10.3. Percent Cloud Cover

Average daily cloud cover value for each day is shown in the table on the Percent Cloud 

Cover tab.  Default values can be overridden by checking the Check to manually enter 

cloud cover data box.  Next, click on the table cell desired, and change the average cloud 

cover value.  Enter cloud cover according to the scale shown.  A zero cloud cover value 

is entered for sunny conditions, 50 for partly cloudy, and 100 for overcast.  Figure 75 

shows the Environment Inputs screen with the Percent Cloud Cover tab selected. 

 

 

Figure 75 - Percent Cloud Cover tab on the Environment Inputs screen



7.10.4. Wind Speed 

Maximum wind speed value for each day is shown in the table on the Wind Speed tab.  

Default values can be overridden by checking the Check to manually enter wind speed 

data box.  Next, simply click on the table cell desired, and change the maximum wind 

speed value.   

7.10.5. Yearly Temperature 

The yearly temperature profile is calculated based on the number of temperature points 

per year selected as shown in Figure 76.  Additionally, under the input Temperature 

Value to Use, users can select to use the average temperature values, the average 

temperature plus one standard deviation, or the average plus two standard deviations.  

The yearly temperature profile is used in calculating the chloride service life.  The 

estimated chloride service life is not very sensitive to the number of data point per year 

selected, but is moderately affected by using the average temperature plus one or two 

standard deviations.   



 

Figure 76 - Yearly Temperature Inputs

data on a graph.  All plots start 

at 1:00 a.m. on the project date selected.  The Temperature button shows a plot of 

temperature data with time.   The Humidity button displays the relative humidity data 

with time.  The Wind Speed tab shows a plot of wind speed with time. The Solar 

Radiation tab shows a plot of solar radiation with time.  The solar radiation values are 

calculated based on the cloud cover data and relative humidity data.  Figure 77 shows the 

Environment Inputs screen with the Summary Graphs tab selected.  The graph shown in 

Figure 77 is a plot of the temperature.  

7.10.6. Summary Graphs

The Summary Graphs tab can display the updated weather 



 

Figure 77 - Summary Graphs tab on the Environment Inputs screen - the temperature graph is

currently displayed 

values are highlighted red. 

 

 

7.11. Input Check

The Input Check screen shows the values that have been entered.  This is the chance for 

the user to see if any mistakes were made in the inputs section of ConcreteWorks.  

Anytime a user enters a character not allowed, ConcreteWorks assumes the value of the 

input to be zero.  For example, if the user types “78u” on the Cement Content input in the 

Mixture Proportion Inputs screen, the Input Check screen would show that the cement 

content is “0”.  Figure 78 shows the Input Check screen.  Notice the default values are 

highlighted green, and the questionable 



 

Figure 78 - Input Check Screen

7.11.1. Default Check

 to use the default program value for an input, the Input Check 

7.11.2. Questionable Values

rature profiles for the 

lement.  A red value simply means that the user should check to make sure that the value 

 indeed what the user wanted.  Caution:  questionable values can (but not always) cause 

Anytime the user chooses

screen will highlight that value in green.  This feature makes it easy for the user to see 

how many entries the user actually made. 

Anytime the user enters a value that the program deems questionable, ConcreteWorks 

highlights that value red.  Just because ConcreteWorks deemed the value questionable, 

does not always mean that the program will not calculate tempe

e

is



instability in ConcreteWorks or give unrealistic results.  This feature makes it easy for the 

user to quickly scan the Input Check screen for common mistakes in entering data.  Table 

15 shows which values are considered questionable by ConcreteWorks.   

 
Table 15 - Values deemed questionable by ConcreteWorks 

Input 
If the input is less 

than this value 
If the input is greater 

than this value 
Rectangular Column Width or Depth 3' 30' 
Rectangular Footing Width, Length or 
Depth  3' 90' 
Rectangular Bent Cap Width or Depth 3' 30' 
T Shaped Bent Cap Width 3' 15' 
T Shaped Bent Cap Height 3' 15' 
Circular Column Diameter 3' 15' 
Cement Content 100# 1200# 
Water Content 100# 1200# 
Coarse Aggregate Content 100# 4000# 
Fine Aggregate Content 100# 4000# 
Air Content 0% 10% 
Class C Fly Ash Content 0# 1200# 
Class C Fly Ash CaO 20% 30% 
Class F Fly Ash Content 0# 1200# 
Class F Fly Ash CaO 0% 20% 
Slag Content 0# 1200# 
Silica Fume Content 0# 1200# 
Ultra Fine Fly Ash 0# 1200# 
Any Bogue Compound Content 0% 100% 
Any Bogue Compound that does not 

  meet ASTM C 150 

C3A 1%  
Blaine Fineness 280(m2/kg) 1000(m2/kg) 
Alkali Content 0% 100% 
Fresh Concrete Placement Temperature 32°F 212°F 
PCC age at form removal 0 hrs  
Delay between removing forms and cure 
method application 0  
Hydration Parameter alpha 0 1 



8. Results 

8.1. Results Summary 

After clicking the Calculate Temperatures button on the Input Check screen, 

ConcreteWorks will begin performing model calculations for the member type selected.  

A progress bar w pear in the lower l he Re howing the 

calculations progress.  If a serious error was made in entering an input, a message box 

w ror.  The Results screen has a different heading, 

d ember shape chosen. 

8 e Checks 

T ws a summary table of the calculated results, as seen in Figure 

79.  The first section in the Mix Checks table st s used to check 

the calculated results (for example, the TxDOT 2004 specifications), the maximum 

t  concrete member during the analysis period, the maximum 

t e t anywhere in the concrete mem d whether the 

c eets the specifications selected or alkali silica reactivity.  The second 

section in the Mix Checks table tells the user the time to corrosion initiation and damage 

e e concrete member.  The last section gives the crack  classification.  

T cation criteria is expl in sections 4.5.  A low or moderate 

c fication does not guarantee th the structural mem er will be free of 

cracks.  A low cracking risk classification only indicates that the probability of cracking 

is lower than if the concrete cracking risk classification were moderate, high or very high.  

Any classification, including the low cracking risk classification includes some chance 

ill ap eft corner or t sults screen, s

ill appear telling the user the er

epending on the type of m   

.1.1. Mixtur

he Mix Checks tab sho

ates the set of specification

emperature in the

emperature difference at tim ber, an

oncrete mixture m  f

stimated in th ing risk

he cracking risk classifi ained 

racking risk classi at b



that cracking will occur.  When the TxDOT 2004 specification is selected, the maximum 

temperature difference line in the Mix Checks table will be highlighted red if the value 

mperature in the member line will be highlighted if the exceeds 35°F, the maximum te

value exceeds 158°F, and the alkali-aggregate reactivity line will be highlighted red if the 

concrete does not meet TxDOT specification 420 (Texas Department of Transportation, 

2004). 

 

Figure 79 - Mix Checks tab shown on the Rectangular Column Temperature Model screen

8.1.2. Max-Min Graph 

The Max-Min Graph tab shows the user a graph of the important calculated values with 

time, as seen in Figure 80.  The values shown are: the maximum temperature anywhere in 

the concrete member at each point in time, the minimum temperature anywhere in the 



concrete member at each point in time, the maximum temperature difference in the 

concrete member at each point in time, and the ambient temperature.   

 

Figure 80 - Max-Min Graph tab as shown on the Rectangular Column Temperature Model screen

8.1.3. Animation

The Animation tab allows the user to view an animated chart of the concrete member, as 

seen in Figure 81.  The Animate button shows the charts and starts the animation from the 

start of concrete placement.  The Stop Animation button stops the animation.  

 calculated property checked in the What to animate? frame.  ConcreteWorks animates the

If no compressive strength parameters are entered in the Material Properties screen (see 

Section 7.8.1), then the Comp. Strength button will be disabled.  The 

CircularColumnfinite screen does not show a three dimensional animation of the concrete 



temperature.  Instead, the CircularColumnfinite screen will show a two dimensional 

animated graph of the temperature on the column diameter cross-section.  When the 

cracking failure classification is calculated, the animation will also display a bar at the 

bottom of the animation that will show the cracking classification at that point in time 

that is being animated. 

 

Figure 81 - Animation tab as shown on the Rectangular Column Temperature Model screen

8.1.4. Maturity

The Maturity tab contains a graph that shows the calculated maximum, minimum, and 

maximum maturity difference for the concrete member, as seen in Figure 82.  The 

maturity is calculated from the strength parameters chosen on the Material Inputs screen 



(see Section 7.8.1).  The calculated maturity is only an estimate, and only applies when 

the maturity parameters entered are from same concrete mixture as the one entered. 

 

Figure 82 - Maturity tab as shown on the Rectangular Column Temperature Model screen

8.1.5. Compressive Strength

The Compressive Strength tab shows the maximum compressive strength, minimum 

concrete strength, and the average compressive strength of the concrete member, as seen 

verage compressive strength is a weighted average of the compressive 

(see Section 8.1.4), and the compressive strength parameters entered on the Mechanical 

in Figure 83.  The a

strength in the member.  This means that the compressive strength of the concrete 

member is integrated, and then divided by the total area.  The compressive strength is 

calculated using the calculated concrete temperature, the calculated concrete maturity 



Properties Input screen (see Section 7.8.1).  If the user does not enter the compressive 

strength parameters in the Mechanical Properties Input screen, the concrete compressive 

strength is not calculated.  The compressive strength graph on the Compressive Strength 

tab is then not visible.   

 

Figure 83 - Compressive Strength tab with compressive strength calculated as shown on the 

as shown in Figure 84. 

Rectangular Column Temperature Model screen

8.1.6. Chloride Concentration at the Steel

As part of the chloride service life analysis, ConcreteWorks calculates the chloride 

concentration at the steel.  When the chloride concentration reaches the chloride 

threshold level, corrosion is considered to have initiated.  The chloride concentration at 

the steel level value will turn orange once corrosion exceeds the chloride threshold level, 



 

Figure 84 - Graph of Chloride Concentration at Steel

8.1.7. Cracking Risk Classification 

The cracking risk classification at different times is plotted as a bar chart, with the 

maximum temperature difference plotted as a blue line on the same graph to show how 

s the cracking risk classification.  Figure 85 

shows the graph used to show the cracking risk classification and maximum temperature 

k classification corresponds to the 

the temperature gradient in the concrete affect

difference.  The bar color shown for the cracking ris

classification shown at the bottom of the chart.  The methodology used to determine the 

cracking risk classification is discussed in section 4.5.  A green color corresponds to a 

low cracking risk classification, yellow to moderate, orange to high, and red to a very 

high cracking risk classification. 



 

Figure 85 - Cracking Risk Classification Chart

8.2. Results Screen Buttons 

The buttons found on the Results screen give the user choices on how to view and 

manipulate the calculated temperature data.   

The Show Comparison Chart button displays a form that allows users to compare the 

results from different analysis runs as seen in Figure 86.  The Show Comparison Chart 

screen is to allow the user to compare calculated maximum temperatures, maximum 

temperature differences, cracking probability classifications, and chloride concentration 

levels at the steel from one mod

8.2.1. Show Comparison Chart

el calculation run to another.  Graphs comparing the 

results will also be displayed. The Print Chart button on the Comparison Chart screen 



will print the comparison chart results and charts on the Comparison Chart. A pdf report 

of the printout will be created when the user clicks on the PDF Comparisons button, and 

will prompt the user for a location to the save the pdf file.  The user may name an 

analysis run by typing in a name under the Series Name textbox, selecting the number of 

the analysis run in the Selected Analysis Number input, and clicking on the Update Series 

Name button.  When a user selects the Delete Series button, the analysis run number 

selected under the Selected Analysis Number will be deleted. 

 

Figure 86 - Comparison Chart screen 

8.2.2. Export Temperature Data

To export the temperature data calculated, click on the Export Temperature Data button 

on the Results screen.  ConcreteWorks saves the data in an ASCII text file when the 



extension .txt is used.  ConcreteWorks will also save the data as an excel spreadsheet 

when the extension .xls is used.  Data will be shown for discrete points in the member 

with time.  The default file extension for data exported is “.xls”. 

ConcreteWorks only displays data in the graphs from two dimensional cross-sections.  

When a footing temperature distribution is calculated in three dim

8.2.3. Cross-Section to be Displayed 

ensions, the user may 

change which cross-section is shown in the graphs by changing the Cross-Section 

Number to be Displayed value, and then clicking on the Display new cross-section 

button, as seen in Figure 87.  The Mix Checks values are calculated for the full three 

dimensional temperature distributions, however, and will not change when the Display 

new cross-section button is clicked.  The temperature data exported when the Export 

Temperature Data button is clicked (as explained in Section 8.2.2) only exports the 

temperature data from the two dimensional cross-section currently selected.   



 

Figure 87 - Rectangular Footing Results screen with the Cross-Section to be Displayed frame showing

9. Program Features

9.1. Printing 

While the Results screen is displayed, the user can print out the results and inputs entered 

in a report format.  

9.1.1. Print 

To print the report, click Print under the File menu.   



9.1.2. Print Preview

To see of preview of the printed report, click Print Preview under the File menu, as seen 

in Figure 88.  The report may be printed from the Print Preview window by clicking on 

the Print button in the Print Preview window. 

 

Figure 88 - Print Preview screen

9.1.3. Page Setup

 screen allows the user to select which graphs to print in the report.  The 

ge Setup under the File menu.  If 

compressive strength parameters are not entered in the Mechanical Properties screen, 

then the Compressive Strength graph will not print, even if the user selects to print it on 

the Page Setup dialog.  The Page Setup dialog can be seen in Figure 89.   

The Page Setup

Page Setup dialog can be opened by clicking on Pa



 

 

Figure 89 - Page Setup dialog 

9.2. Export 

The ConcreteWorks inputs and results can be exported to a pdf file.  The pdf file exported

is similar to the printed reports.  To make the pdf report, select “pdf” from the “Export 

le menu.  The software will then prompt the user for a location to 

departments of 

transportation.  The export to SiteManager™ function in ConcreteWorks will create an 

 

to” option under the Fi

save the pdf file.  It may take a few minutes for the software to generate the pdf file.  

After the file has been generated and saved, ConcreteWorks will display a message that 

the pdf file was generated. 

ConcreteWorks also contains an option to export the inputs to SiteManager™.  

SiteManager™ is an AASHTOWare® product  used by several state 



xml file that can be used to import ConcreteWorks inputs into SiteManager™.  For more 

information on the procedure to import the xml file generated by ConcreteWorks, contact 

the Texas Department of Transportation.   

 

9.3. Save As 

To save the inputs entered in a new file, click Save As under the File menu.  The default 

file extension for an inputs file is “.dat”.   

9.4. Save File 

To save a currently opened file, click the Save button, or click Save under the File menu.  

If the Save button is clicked and the file has not previously been saved, the program will 

prompt for a name and location.   

9.5. Change Defaults 

Click the Change Defaults item under the File menu to change the default values used for 

same tab.  The Material Inputs tab on the Change Defaults 

screen

inputs to custom values.  All values entered in the Change Defaults screen are input in 

English units, but are displayed in the correct units in the inputs section of 

ConcreteWorks the next time a new file is opened.  All units stay the same in the Change 

Defaults screen, except for the a and b strength parameters under the Mechanical 

Properties tab.  The a and b parameters change units depending on the type of maturity 

function chosen under the 

 is seen on Figure 90. 

 



 

Figure 90 - Material Inputs tab on the Change Defaults screen 

elected, as explained in sections 3.1.5 and 4.4.1.   

The specification used in the results check section can be changed by selecting the 

desired specification from the Specifications Used option under the Tools menu.  

9.6. Tools Menu

The Tools menu contains a few options that increase the power and versatility of 

ConcreteWorks.  The first is the analysis method used to calculate the cement chemical 

properties.  To select the Bogue method of determining the cement composition, select 

Bogue (ASTM C 150) under the Cement Analysis Method under the Tools menu.  To 

select the Rietveld method of determining the cement chemistry, select Rietveld under the 

Cement Analysis Method under the Tools menu.  Different equations are used to 

determine the concrete heat of hydration and early age concrete creep properties based on 

the cement analysis method s



ConcreteWorks currently only contains the 2004 specifications for the Texas Department 

of Transportation.  If the Basic ASR and DEF specification is selected, ConcreteWorks 

will check to see if the predicted maximum temperature exceeds 160°F, and if the 

minimum amounts of SCMs prescribed by TxDOT in the 2004 specification are used.  If 

the minimum amounts of SCMs are not used, then a warning that more investigations 

should be done is shown.  Caution should be used in interpreting this check for alkali-

silica reaction (ASR).  Specifications that require the use of minimum amounts of 

supplementary cementing materials or maximum cement alkali levels to reduce the 

likelihood of ASR do not guarantee that this deleterious reaction will be prevented.  

Alkali silica reaction is highly dependent on the aggregate type, type and quantity of 

supplementary cementing materials, alkali loading, and exposure environment.   

ation about the ConcreteWorks 

When the user clicks on the About ConcreteWorks item under the Help menu, a splash 

screen appears with information on the ConcreteWorks version being used, a link to the 

official ConcreteWorks website, www.texasconcreteworks.com

9.7. Help Menu 

The Help menu provides the user with useful inform

program.   

9.7.1. About ConcreteWorks

, and a button that shows 

the End-User License Agreement.  When the link to the official ConcreteWorks website 

is clicked, ConcreteWorks uses Internet Explorer® to navigate to the website.  This is the 

reason that Internet Explorer is required for using ConcreteWorks as described in Section 

6.2. 



9.7.2. View User Manual 

When the user clicks on the View User Manual item under the Help menu, the 

ConcreteWorks User Manual is opened as a new Adobe Reader® process.  This is the 

reason that Adobe Reader® is required for using ConcreteWorks as described in Section 

6.2. 

10. Input Sensitivities 

ConcreteWorks asks the user to input a lot of data.  To receive a correct answer, the user 

must enter correct data.  Some of the data needed may be hard to obtain.  Other data have 

less of an effect on the calculated results and performance of the model.  This section 

contains some comments on these input sensitivities. 

10.1. Environment Inputs Sensitivity 

ember to the surrounding environment.  Of the four types of environmental 

erature inputs have the greatest impact on the resulting temperature 

distribution in the element.  The relative humidity and cloud cover inputs have a 

moderate effect on the data.  A percent cloud cover value within 30% is generally 

acceptable.  The wind data can also have a moderate effect on the calculated 

temperatures.   

st factors in the run speed of the program are: 

All of the Environment Inputs directly affect the way heat is transferred to or from the 

concrete m

inputs, the temp

10.2. Run Speed 

The run speed of the program is one of the biggest concerns to many designers.  The six 

bigge



1. The computer speed and computer RAM 

duration of 4 days may have a run time several times that of a 3 day analysis, 

instead of the expected 33% longer runtime.  

ment, the longer the run-time  

6. Three dimensional analysis greatly increases the run-time compared to a two 

dimensional analysis. 

ft.NET\Framework.  Before installing or deleting any files or 

folders, make sure that the owner of the computer or appropriate network administrator is 

contacted to obtain permission and / or assistance.   

2. Analysis duration – A 14-day duration takes longer to run than a 5 day duration.  

When a thermal stress analysis is performed, the analysis duration has a very large 

impact on the run time.  Because of the numerical methods used, an analysis 

3. Member size – the larger the ele

4. Concrete age at form removal -  the greater the time before form removal, the 

greater the run-time 

5. Cure method after form removal -  if a cure blanket is used after form removal, 

the run-time is longer 

11. Troubleshooting 
11.1. Installation Problems 

If more than one version of the .NET Framework is installed, errors may occur during 

installation or when the ConcreteWorks is started.  To resolve the issue, try deleting the 

folder containing the old version of the .NET Framework, usually found in the directory 

C:\WINDOWS\Microso
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The

appeara

correct

settings

display p.  Then click on the Settings tab.  

The
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